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Introduction 
Creating Futures is a 4-year project funded by the New Zealand Foundation for 
Research, Science and Technology (FRST). The project brings together an 
interdisciplinary team consisting of a key end user (Waikato Regional Council, WRC) 
and social, environmental and economic researchers. The project aims to develop new 
methods and tools to support integrated, long-term planning by 1) developing 
processes to evaluate, deliberate, and choose futures through scenario analysis and 
multi-criteria deliberation frameworks and 2) develop an integrated spatial decision 
support system (ISDSS) to support the evaluation and deliberation processes. 
Together these tools will help Waikato Regional Council and other councils evaluate 
links and trade-offs between economic, environmental and social/cultural outcomes 
and the cumulative effects of many decisions over space and time. 
 
An ISDSS is an Integrated Spatial Decision Support System designed to help examine 
weakly-structured or unstructured problems characterised by many actors, many 
possibilities, and high uncertainty. The Waikato Integrated Scenarios Explorer, or 
WISE, is being developed for the Waikato region to support evaluation and deliberation 
of strategies and scenarios related in the context of Waikato Regional Council‟s long-
term planning. 
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User Manual – An Overview 
 
 
This is an overview of the user manual of WISE, an integrated spatial decision support 
system built with the GEONAMICA framework. WISE is developed for the Waikato 
region to support Waikato Regional Council‟s long-term council community planning 
process. 
 
This manual contains five sections: 
Section 1 “Getting started” explains how to install WISE on your computer and how to 
start the program. It also describes the main features of the graphical user interface. 
 
Section 2 “Running the simulation” contains a step-by-step description of how to run a 
simulation in WISE. 
 
Section 3 “Policy interface” describes the steps that a policy user should follow to carry 
out an integrated impact assessment with WISE. 
 
Section 4 “Modeller interface” describes the interface for a modeller to access the 
underlying models and to update data and parameter settings through the system 
diagram in WISE. 
 
Section 5 “The WISE menu system” offers a systematic description of each option in 
the menu system. 
 
Through this documentation, for the convenience of the user, a special arrow symbol  
is used in a step-by-step description of how to complete the action that you can follow 
along at your computer.  For example:  
 Click Open project … on the File menu. 
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1 Getting started 
This chapter explains how to install WISE on your computer and how to start the 
program. It also describes the main features of the graphical user interface. 

1.1 Computer requirements 

WISE runs on personal computers running Microsoft Windows XP and equipped with 
modern Intel or Intel compatible processors. It may also run on Windows 2000 and 
Vista, but has only been fully tested on Windows XP. To use WISE, your computer 
should have the following hardware components: 

 At least 1GB of RAM 

 A hard disk with at least 10GB free  
 
To make full use of the application, you should have the following software packages 
installed on your computer: 

 Microsoft® Excel (version 97 or later) (required) 
 
If you experience problems when installing WISE on Windows Vista, please can 
contact us (see the section If you experience problems). 

1.2 Installing WISE and accompanying tools 

The following is a step-by-step description of the installation of WISE. The 
installation/uninstallation of WISE follows standard Windows procedures. 
 
If you have a previous version of the WISE software installed on your machine, you will 
be asked whether you want to uninstall it first. We recommend uninstalling it. If you 
would want to keep it, make sure to put the latest version of WISE in a separate 
directory. During the installation you may encounter a message asking whether you 
want to keep or replace certain files. We recommend replacing those files for use with 
WISE. Keeping the old files may cause the software to malfunction. 
 
To Install WISE: 
 
 Step 1. Start Microsoft Windows XP. 
 
 Step 2. Insert the WISE cd-rom into the drive.  
 
 Step 3. Double-click on the WISE_#.#.#_setup.exe on the WISE cd-rom. the #.#.# 

refers to the version number of the software installation. 
 
 Step 4. The wizard is started. Press the Next button. 
 
 Step 5. The installation program asks you to choose the components of WISE you 

want to install. Select the WISE option and data option and press the Next button. 
 
 Step 6. The installation program asks you to choose the install location for the 

program destination folder. The default path for installing the WISE programme is 
C:\Program Files\Geonamica\WISE. if you want to install WISE in a different 
directory, press the Browse... button and navigate to the desire location. Press the 
Next button. 

 
 Step 7. The installation program asks you to choose the install location for the data 

destination folder. The default path is C:\Documents and Settings\My 
Documents\Geonamica\WISE. If you want to install the data in a different directory, 
press the Browse... button and navigate to the desire location. Press the Next 
button. 
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 Step 8. The installation program suggests adding WISE to the new program group 

Geonamica. You are free to create another group or to choose an existing one from 
the list shown. Press the Install button.  

 
 Step 9. The installation programme now installs all the files and data needed to run 

WISE into the directories that you have selected. If you selected that option in step 
8, the installation programme also creates a programme group named Geonamica 
under Start → Programs that contains a shortcut to WISE. 

 
 Step 10. When the installation is complete, press the Finish button.  
 
 Step 11. Follow the procedure outlined in the steps 1 to 10 to install the Map 

Comparison Kit on the WISE cd-rom. 
 
To uninstall WISE: 
 
 Step 1. Click the Start button in the Windows taskbar. Move the mouse pointer to 

control Panel and click. The Control Panel window will open. Select the Add or 
Remove Programs icon by double clicking on it. Next click the change or remove 
programs button in the Add or Remove Programs Properties dialog window. 

 
 Step 2. Select WISE from the list of applications that can be automatically removed 

by Windows and press the Change/Remove button. 
 
 Step 3. The Confirm File Deletion dialog window will open. Press the OK button to 

confirm that you want to remove WISE and all its files from your hard disk. 
 
 Step 4. Repeat the steps 1 to 3 to uninstall the Map Comparison Kit. 

1.3 Wise directory structure 

By default WISE is installed in the directory C:\Program Files\Geonamica. The WISE 
directory includes Geonamica.exe and all the DLL-files required running the WISE 
system.  
 
By default data for WISE is installed in C:\Documents and Settings\User\My 
documents\Geonamica\WISE. You will see the following directory structure. 

 

 
 

These directories include all the project files, data files, and intermediate map outputs 
needed to run WISE. Here you will also find the WISE project file, recognizable by the 
extension *.geoproj. The project file contains the basic information the software needs 
to run a simulation. The data part of WISE typically contains the following sub-
directories and files: 

 Animations: animation maps generated during a simulation 
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 Cache: zoning maps generated during a simulation 

 InputMaps: base maps required to run a simulation  

 IntermediateMaps: intermediate output maps for the current simulation year 

 Legends: map legends 

 Log: logged maps generated during a simulation 

 Waikato.geoproj: the project file of WISE.  

1.4 Map Comparison Kit directory structure 

By default the Map Comparison Kit is installed in the directory C:\Program 
Files\Geonamica. The Map Comparison Kit directory contains the Map Comparison Kit 
application (MCK.exe) and a set of DLL-files that the application requires to run.  

 
 
By default additional data for the Map Comparison Kit are installed in C:\Documents 
and Settings\User\My Documents\Geonamica\MCK. There are four sub-directories in 
this folder: 

 Examples: examples developed for the Map Comparison Kit 

 Palettes: palettes legends for the Map Comparison Kit 

 Results: results generated with the Map Comparison Kit 

 Temp: temporary outputs (e.g. reference maps) generated with the Map 
Comparison Kit. 

 

 
 

1.5 Starting WISE 

Once installed, you can start the WISE application as follows: 
 Click the Start button on the Windows taskbar 
 Go to All Programs → Geonamica → WISE. 
 Click the GEONAMICA icon . 
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1.5.1 Importing the licence file 

The first time you start WISE a dialog window will appear asking you to install a licence 
file for WISE.  
 

 
 

 Click the OK button on the message window. 
 
A dialog window will open allowing you to navigate to the folder where you put the 
licence file for WISE that you received from RIKS.  
 Select the licence file with the extension *.lic 
 Press the Open button of this dialog window.  
 
The licence file will be created automatically in the same directory as Geonamica.exe. 
After this, the system will not ask you again to open the licence file when you start 
WISE. 
 
Each time you start WISE, the About window appears (see the section About). 
 Click the OK button on the About window. 

1.5.2 Opening the project file 

 After you press the OK button on the About window, the Open project file dialog 
window opens.  

 Navigate to the project file that you want to open and double-click on it. 
 

 
 
If the project file you want to open is created with an older version of WISE, a message 
window appears to ask you whether to upgrade the project file to the current version of 
software.  

 Click the No button to exit the action. You could not open it with the current version 
of WISE. You can only open it with the older version of WISE with which you 
created this project file. 

 Click the Yes button to upgrade the project file automatically. Then you can open it 
with the current version of WISE. 
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WISE will be started and you will see the WISE - ### application window on your 
screen, where “###” is the project file name that you selected. 

1.6 Screen layout 

When you start WISE, the application window opens immediately. This is the window in 
which you will run your models. You can arrange windows as you like in the application 
window. Before a project file has been opened, the window is empty except for its 
Caption bar, Status bar, Toolbar and Menu bar. The different components of this 
window will be described in the next paragraphs. 
 

 

1.6.1 Caption bar and menu bar 

The Caption Bar, also called title bar, of the application window shows the name of the 
application: Geonamica. As soon as a project file is opened, the title will be extended 
with the name of the project file.  
 
The Menu Bar of the application window contains the main menu of WISE. The 
commands are logically organised in the menu so that you will quickly become 
comfortable with the various functions of the software. The menus are summarised in 
the table below; subsequent sections elaborate on the description. The section The 
WISE menu system gives an overview of all menu commands. 
 

Menu Function 

File Manage your project files 

Simulation Control the simulation 

Options Customise the workspace and select types of output 

Window Manage your windows on the screen 

Help Look up the system information and find help 
documentation 

1.6.2 Toolbar 

The Toolbar gives faster access to some of the more frequently used commands that 
are also accessible via the menu.  

Status bar 

Toolbar 

Application Window 

Menu bar Caption bar 
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Button Function 

 Open a project file from the disk 

 Save a project file to disk 

 Advance the simulation with one simulation step 

 Advance the simulation till the next pause is reached 

 Stop the simulation after the current step is finished 

 
Reset the simulation and switch the simulation clock back 
to the initial year of simulation 

 
A list box next to Integrated scenario is also displayed on the toolbar. All available 
integrated scenarios are displayed on the dropdown list where you can select – that is, 
load – an integrated scenario. When collapsed, the list box shows the name of the 
active scenario. 

 
 
The Toolbar also displays the simulation clock. Each time step, the clock is updated to 
match the current value, which means that it increases with steps of1 year in WISE. 

1.6.3 Status bar 

The Status bar is displayed at the bottom of the application window. This area provides 
information to you on your actions while you are working with the application. The 
Status bar describes the following information: 

 When you use the mouse or arrow keys to navigate through menus, it describes 
actions of menu commands. 

 When you press the buttons on the toolbar, it describes actions of this button. 

 When you move the mouse on a raster map, it describes the location of the cell that 
is pointed and the category or value on this cell is displayed in brackets. 

 When you move the mouse on a network map, it describes the x and y coordinators 
of the location. 

 
The Status bar also indicates which of the following keys are latched down: the Caps 
Lock key (CAP), the Num Lock key (NUM), or the Scroll Lock key (SCRL). 

1.7 System Information 

The different commands in the Help menu allow you to look up the system information 
about WISE, its commands, options, and tools. You can use the Help menu to select 
the type of information that you want WISE to display on the screen. For more 
information see the section Help menu. 

1.7.1 Index 

You can use the Index command to get the opening screen of the on-line help file of 
WISE. From the WISE documentation opening screen, you can jump to step-by-step 
instructions for using Metronamica. Click the topic that you want help on. Once you 
open the WISE documentation on-line help window, you can click the Close button 
whenever you want to exit. 

1.7.2 Licence 

You can use the Licence… command to get the licence information in the Licence 
window. All licences for the Geonamica-based software stored on your computer will 
be listed in the Licences found table  
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The system allows you to import the licence file by pressing the link of Read a licence 
file… to open the Open dialog window and select the licence file you received from 
RIKS.  
 
After reading a licence file, the system will create files relevant to license under a 
folder. You can click on the Open licence folder… button to view the files and the 
directory of this folder. 
 
You can use the Licence… command to get the licence information in the Licence 
window. The system allows you to import the licence file by pressing the link of Read a 
licence file… to open the Open dialog window.  

1.7.3 Checking for updates 

You can use the Check for updates… command to check if you are using the latest 
version of WISE software. If the software you are using is not the latest one, the 
system will provide you information about how to request an update of the software. 

1.7.4 About 

You can use the About… command to open the About window. You can find here the 
copyright notice and version number of WISE that you are using. The latter is important 
if you need assistance with the software from the developers (see the section If you 
experience problems) or when you request an update of the software. 
 

 

1.8 Closing WISE 

You can use the Close project command to close WISE. 
 Click the File menu and click Close project. 
 
If you have a project file open and you have made any changes, one message window 
will pop-up and will ask whether you want to save changes before closing.  
 

 

Version number 
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If you confirm that you want to save changes, you will get the Set external file names 
dialog window.  
 Click the Yes button of the Save dialog window to carry out the action of saving and 

closing.  
 
More information on saving changes is given in the section Saving changes of this 
manual.  

1.9 If you experience problems 

If you experience problems installing or running WISE, please contact us with the 
version number of the Geonamica application that you are using (see the section 
About): 
 
Research Institute for Knowledge Systems bv. 
To the attention of Hedwig van Delden 
P.O. Box 463, 6200 AL Maastricht, The Netherlands 
Tel: +31 (43) 3501750 
Fax: +31 (43) 3501751 
E-mail: info@riks.nl 
Website: www.riks.nl 
 
 

http://www.riks.nl/
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2 Running the simulation 
This section describes the primary steps of running a simulation with WISE: Opening a 
project file, editing input and displaying output, saving changes, running a scenario, 
saving results and analysing results. 

2.1 Project file, integrated scenario and sub-
scenario 

It is important to understand how the input data/files and parameters that are required 
to run models in the system are organized in WISE. We use the terms Project file, 
Integrated scenario and Sub-scenario to describe the different levels of data and file 
management and parameter value settings.  
 
In the context of this document a scenario is considered to be a set of values for each 
driver in WISE (for more information on drivers in WISE, see the section Setting up the 
drivers). In particular, you can make scenarios for each of the drivers that are 
accessible through the Main window. For example in the external factors you can 
define increased international exports for the relevant economic sectors and call this 
scenario High export.  
 
When you want to run a simulation in order to investigate the effects of a scenario, you 
will have to select exactly one scenario for each of the drivers in WISE. This 
combination would also be named a scenario according to the definition of the term 
given above, but of course that is a recipe for confusion. To avoid such confusion we 
will qualify the term scenario to mean one of two things:  

 A Sub-scenario is a set of values for one of the drivers in WISE that defines a 
possible future development of that driver. 

 An Integrated scenario is a combination of one sub-scenario for each driver in 
WISE that together define a possible overall future development. 

 
This means that the High export scenario mentioned above is a sub-scenario and that 
an integrated scenario defines all the values for all the drivers that are needed in order 
to perform a simulation run. The selected integrated scenario on the toolbar is called 
the active integrated scenario. 
 
It should be noted that only sub-scenarios store values for each driver; integrated 
scenarios do not store values themselves as they are just a collection of sub-scenarios. 
Also, sub-scenarios can exist outside of integrated scenarios – e.g. several predefined 
sub-scenarios for climate change exist, though initially only one of them is selected in 
an integrated scenario. 
 
A project file is used to configure various parts of the simulation and it contains 
references to all the files that are required to run models in the system. The project file 
used in WISE has the extension *.geoproj. A project file contains at least one 
integrated scenario. The locations of input data and files and parameter values of all 
integrated scenarios can be stored in a single Project file. A project file must have at 
least one Sub-scenario specified for each driver. At most one Sub-scenario per driver 
can be indicated as the Baseline scenario which is by default read-only. This prevents 
users from making changes to that Sub-scenario. Additional Sub-scenarios that are 
created by the user are not read-only. See the section Saving changes for more 
information on how to save a Sub-scenario, Integrated scenario or Project file.  

2.2 Opening a project file 

In the section Getting started we explained how to install and start WISE. We assume 
from now on that you have read this information, that you have successfully installed 



 

WRC Doc # 2012288 Page 13 

WISE on your computer and that you have knowledge of the different technical terms 
introduced. 

2.2.1 Opening an existing project file 

Make sure that you have started the WISE (see the section Starting WISE) and that the 
Geonamica application window is open on your screen. 
The Open project file dialog box appears. If the open dialog box is not on your screen,  
 Press the Open button on the toolbar or click Open project … on the File menu. 
 In the Open project file dialog window, click the look in dropdown arrow and 

navigate to the WISE folder where you installed the data and project files. 
Remember the default installation path is C:\Documents and Settings\My 
documents\Geonamica\WISE. 

 Double-click Waikato.geoproj or click Waikato.geoproj and press the Open button. 
 
Once all files have been loaded, two windows appear in the application window: the 
Main window and the Land use map. These windows cannot be closed! You can move 
them and change their size to organise your workspace, including minimizing or 
maximizing them, but cannot close them. 

2.2.2 Main Window 

The Main window is divided into two parts: the navigation pane to the left of the splitter 
bar and the content pane to the right. The navigation pane consists of 4 tabs: Drivers, 
Scenarios, Indicators and Analysis. If one of the tabs is clicked, the list of elements 
appears below the tab. Clicking on an elements, the underlying contents is displayed 
on in the content pane on the right side of the main window. You can expand one of the 
tabs by clicking on this tab and you can close this tab by clicking another tab. 
 

 
 
The Main window provides access to the policy user and the modeller interface. the 
section Policy interface and the section Modeller interface provide detailed descriptions 
of interface for these two types of users. 

2.3 Editing Input and displaying output 

In the system of WISE, input and output are organised by the following categories: 

 Map file 

 Graph 

 Single value 

 Table. 
 
The following sub-sections describe how to edit input and display output for each of 
those by categories.  

Navigation pane 

Content pane 
pane 

 
Content pane 
pane 

Splitter Bar 

 
Splitter Bar 

Tab 

 
Tab 

Section 

 
Section 
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2.3.1 Map window 

The Land use map window is a Map window, which we will use as an example. A Map 
window is split into 5 viewing areas, called panes. You can open and close Map 
windows, except for the Land use map window. Beware: opened Map windows are 
updated while a scenario runs. This consumes processing time and will slow down the 
overall program. 

 

2.3.1.1 Splitter bar and overview pane 

Panes are separated from each other by means of splitter bars. You can move the 
splitter bars to change the size of a pane.  
 
The overview pane is displayed in the lower-left portion of the Land use map window. It 
displays the entire modelled region, in this case the Waikato region. A wire-frame 
rectangle outlines the portion of the region that is currently displayed in the map pane. 
You can move the wire-framed rectangle by placing the mouse pointer inside it and 
clicking and holding the left mouse button. Moving the rectangle moves the map in the 
map pane accordingly.  

2.3.1.2 Map pane 

The map pane is located in the middle of the Land use map window and displays a 
land use map for the modelled region. Specifically, the land use map for the current 
simulation year is shown. The map pane is equipped with both vertical and horizontal 
scroll bars. If you cannot see all the complete contents of the map pane, use the Zoom 
tools in the tools pane to adjust the image appropriately, e.g., zoom in/out, pan 
horizontally/vertically. 
 
Land use information is presented for each grid cell. The cell states on the map 
represent the predominant land use on that location. To the left of the map pane is a 
legend pane that displays the land use legend.  When a simulation is running, the Land 
use map window will be updated after each time step. 
 
You can access the summary information on the land use map by double-clicking in the 
map pane. This opens the Contingency table Land use map and Districts map dialog 

Legend 
pane 

Map pane Overview pane 

Splitter bar 

Layer manager pane 

Tools pane 

Layer visibility 

Scroll bar 
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window that shows the number of cells and area surface of each land use for each 
district. You can select the unit for the area surface from the dropdown list next to 
Display values in. The table displays the summary in the selected unit. If you select the 
check-box next to Include cells outside modelling area, the land use outside the 
modelling area will be displayed in the first column. If this check-box is unselected, all 
the values in the first column should be zero. The total number of cells or area surface 
of each land use is displayed on the right-most column of the table. 
 

 
 
You could inspect the information on a specific location by right-clicking in a map. The 
context menu appears. When you click on the Cell information item, the information of 
the districts map and the selected map for that location will be displayed in a yellow 
box. You could also access the same information by using the Inspect tool. For more 
information about the Inspect tool, see the section Grid tools. 
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2.3.1.3 Legend pane 

The legend pane is displayed in the upper-left portion of the Map window. It shows the 
legend of the map selected in the Layer Manager (explained below). For example, if 
you select a land use map, the legend pane shows the legend of land uses. 
 
The land use is subdivided into 3 types: Vacant, Function, Feature. In the legend of the 
map, the Vacant states appear at the top of the list, the Function states appear in the 
middle of the list and are underlined, and Feature states appear at the bottom of the 
list. The 3 different land use types are explained later in the section Land use classes.  
 

 

2.3.1.4 Layer manager pane 

The layer manager pane is displayed in the upper-right portion of the Land use map 
window.  It lets you turn map layers on and off in the map pane. In the example above, 
two maps are available: Land use map and District boundaries. Often other maps will 

also be available. Clicking on the button to the left turns map layer visibility on   or 

off  . 
 

Button Function 

 
Turn on layer visibility 

 
Turn off layer visibility 

 
The WISE system allows you to view multiple layers simultaneously. Note that the 
District boundaries map layer is displayed in all Map windows.  

2.3.1.5 Tools pane 

The tools pane is displayed in the lower-right portion of the Map window. It shows the 
tools for viewing and editing selected map layers and includes the Zoom tools, Grid 
tools, and Network tools. You can open the context menu of the tool pane by right-
clicking, which controls how tools are arranged on the desktop.  



 

WRC Doc # 2012288 Page 17 

 

2.3.1.6 Zoom tools 

Use the Zoom tools when you would like to see a location in more detail.  
 

Button Function 

 
Zoom in 

 
Zoom out 

 
Pan 

 
Zoom to selected  

 
Fit whole map to window 

 
When you activate one of these buttons and click the mouse pointer on the map, you 
can carry out the selected zoom option. 

2.3.1.7 Grid tools 

Use Grid tools to edit and view the information of the editable raster or grid maps that 
you have selected. 
 

Button Function 

 
Change the pointer to a pen. The pen is used to pick a value 
from the legend and enter it in a cell on the map. 

 

Change the pointer to a bucket. The bucket is used to pick a 
value from the legend and enter it in larger, contiguous areas of 
the map. 

 
Display the information of the selected map on the map 
windows. 

 

Copy the shape and colour information in the selected area from 
another grid layer to the current grid layer. This option is not 
available in WISE. 

 

Copy the colour information on the selected area from another 
grid layer to the current grid layer. This option is not available in 
WISE. 

 Save the grid map that you select. 

 
From the current land use map, accessible via Drivers → Parameters → Land use→ 
Land use tab → Show current land use map button, you can derive more information 
by using the Inspect tool. In the Potential figures dialog window that will open, the 
numbers displayed in the title represent the location in row and in column of the cell 
that you selected. The table lists the values for total potential, neighbourhood potential, 
suitability, numerical zoning and accessibility for each land use function for the selected 
location. This functionality is very useful during calibration. 
 

Edit, check and save grid map 

Expand all the tools 
in map window 

Close all the tools 
in map window 

Change the manner in which different 
maps of map window are displayed 

Edit and display network map 
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2.3.1.8 Network tools 

The Network tools become enabled only when a network map window is open. In 
WISE, there are several ways to open a network map window: through the Maps menu, 
through the policy user interface or through the modeller user interface. For more 
details, we refer to the section Network map window opened via the policy user 
interface and the section Network map window opened via the modeller user interface, 
respectively. 
 
You can use the Network tools to view or edit the infrastructure network.  
 

Button Function 

 Change the mouse state to select or edit.  

Left-click on a link to select the link; Double-click on a link to 
edit the properties for the selected link; Left-click on a node 
to select the node; Change the location of the selected node 
by dragging it to a new location. 

 Change the mouse state to draw links and nodes. Pointer a 
location and drag the mouse to draw a new link; Left-click on 
a location to add a new node. This button will be greyed out 
for the non-editable maps. 

 Change the mouse state to draw nodes. Left-click on a 
location to add a new node. This button will be greyed out 
for the non-editable maps. 

 Select this check box to display nodes of a network in the 
map pane; Clear this check box to not show nodes on the 
network map. 

 
Select this check box to display links of a network in the 
map pane; Clear this check box to not show links on the 
network map. 

 
When the selected network layer is editable, the Add link and the Add nodes buttons in 
the Network tools section of the tools pane becomes enabled and the radio buttons in 
front of the legend appear in the legend pane on the top-left part. You can practice how 
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to use the tools under the Network tools tab to add link and to change the properties of 
link. 
 
When you close the map window on which you made changes, one message window 
pop-ups to ask whether you want to save the changes you made or not. Press the No 
button not to save the changes you made. You can save the changes you made by 
clicking the Yes button and giving a new name with the extension .shp. For more 
information about how to work with an editable map, see the section Editable map. 
 

 
 

 If it is only for the purpose of practising, do not save changes you made.  

 Be aware that when you press the Yes button, you should give the map a new 
name. Otherwise, the map which you loaded previously will be overwritten. 

 
You can use one of the link properties to present the link color for the network map. To 
do so, select the link property of interest from the dropdown list next to Color master 
field. In other words, the categories of the selected property of a link will be used as the 
color legend of the network displayed in the map pane. Similarly, you can use a link 
properties selected in the Line width master field to present the link width for the 
network map. For maps that display infrastructure elements, the Acctype is used by 
default to display the network map. The color legend and width legend are predefined 
in the system (see the section Network legends). You don‟t need to change them. 

2.3.1.9 Network legends 

The table below gives an example of the values and categories of the Acctype used to 
display network layers (e.g. transport network, major processing sites, residential 
attractants) in the system. 
 

Acctype category Acctype value Legend 

Residential road -1 

 

Collector route 0 

Arterial route 1 

Principal highway 2 

Major highway 3 

Railway 4 

Dairy processing 5 

Timber processing 6 

Abattoir 7 

Residential attractants 8 

 
For other properties, you can create and edit your own legend on the Link color tab by 
double-clicking the legend pane. For more information, see the section Legend editor. 
 Select the check box Show nodes to display the nodes of a network in the map 

pane. 
 Select the check box Show links to display the links of a network in the map pane. 

2.3.2 Legend editor 

Each land use map, potential map, neighbourhood effect map, accessibility map, 
zoning map and network map in WISE is presented with its dedicated legend. These 
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legends are completely customizable. The legends may contain the colour information 
for the different classes or they may apply colours from a palette file. 
 
A legend is a classification of values in a map and a mapping of those classes to 
several other characteristics, such as labels, ranges or colours. Basically, there are two 
distinct types of legends, namely categorical and numerical legends. Categorical 
legends divide the possible values in a map into categories that have a name and a 
colour. An example of a map with a categorical legend is the land use map in the Land 

use map window. Numerical legends make a partition of a range of values into smaller 
ranges – the classes – and allocate a colour to each class. Numerical legends are 
often useful for indicator maps. 

2.3.2.1 Categorical legends 

Double-clicking on the legend of the map window of interest opens the Legend editor 
dialog window where you can view and edit the legend for this map. The figure below 
shows the Legend editor dialog window for a land use map (categorical map). 
 

 

To import an existing legend file for the map of interest: 
 Click the Import button. A window will open where you can select an existing legend 

file (*.txt). The information in the Legend editor dialog window will be updated 
according to the newly imported legend file.  

Note that the name of the legend file is not editable and will not change if you import 
another legend file. Whenever you press the OK button at the bottom, the changes you 
made in the Legend editor dialog window will be saved in the legend file displayed in the 
text box next to File. Changes made in the Legend editor dialog window will not be saved 
in the legend file if you press the Cancel button. 
 

To define the legend type: 
 Select the appropriate legend type for the selected map from the dropdown list next 

to Legend type. The contents of the table in the legend editor will be updated 
accordingly. 

 

To define the number of classes: 
The number of classes of the legend is displayed next to Number of classes. 
 You can increase or decrease this number by clicking on the up or down buttons or 

entering a new number in the text box.  
For a Categoric legend, you can also derive the number of classes from the map itself 
by clicking on the Derive from map button. The number of lines in the table will be 
updated when you change the number of classes. 
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To edit labels: 
 Double-click on the label of the class of interest to manually adjust its name. 
 

 
 

To manually edit colours: 
 Double-click on the cell in the Colour column for the class of interest to adjust its 

colour. The Colours dialog window opens. 
 Select the desired colour either through the Standard tab or the Custom tab. 
 Press the OK button to close the Colours dialog window. 
 

 
 

To generate colours: 
You can also apply a predefined palette to the classes in the legend.  
 Click on the Generate colours… button to open the Generate colours dialog 

window. 
 Make sure Predefined is selected. 
 Select an option from the dropdown list just below the Predefined label. 
 Press the OK button to close the Generate colours dialog window.  
The Top and Bottom labels indicate how the colours will be applied in the table. The 
colour on the left will be applied to the top line in the table; the colour on the right will 
be applied to the bottom line. 
 

 
You can also apply a customized colour scheme to the classes in the legend. The 
Custom part of the Generate colours window allows you to easily make a smooth 
palette that blends from one colour to the next. 
 Click on the Generate colours… button to open the Generate colours dialog 

window.  
 Click on the Custom radio button.  
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 Click on one of the boxes just below the custom colour scheme in order to select it. 
The dropdown list under Edit colour will display the colour of the selected box. 

 You can change the colour of the selected box by clicking on the dropdown list 
under Edit colour. 

 You can add intermediate boxes to blend from one colour to the next by anywhere 
on the custom colour scheme between Top and Bottom. 

 You can delete an intermediate box by right-clicking on the box and selecting 
Delete from the context menu.  

 Press the OK button to close the Generate colours dialog window and apply the 
colour scheme to the legend. Press the Cancel button to keep the legend colours 
as they are. 

 

 
 

To save the legend: 

 Press the OK button in the Legend editor dialog window to save the changes you 
made for this legend. The map will now be displayed using the new legend. 

2.3.2.2 Numerical legends 

The figure below shows the Legend editor dialog window for a numerical legend. As 
you can see, more functions are available than for a categorical legend, namely 
generating labels and generating class bounds. 
 

 
 

To manually adjust class bounds for a numerical legend: 
 Make sure Numeric is selected on the dropdown list next to Legend type. 
 Click on the upper or lower bound you want to change and enter the new value.  
If the lower bound is larger than the upper bound, the values will be highlighted in red. 
Note that you cannot save the legend until you have adjusted these values. 
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To generate class bounds: 
 Click the Generate class bounds button. The Generate class bounds window 

opens.  
 Click on the dropdown list next to Order to choose the order of legend entries. 
 You can specify the total range of the legend in the Display interval part by entering 

values in the Minimum value and Maximum value text boxes. Check the Choose 
automatically box to fill these values with the lowest and highest values in the map.  

 Select a scaling method from the dropdown list in the Scale part.  
When a method is selected, the class ranges will be calculated, as well as an 
estimated effectiveness of the chosen scale that can range from 0 to 100%, where a 
higher value indicates a better scale. If the Find best scale button is clicked, the legend 
editor will iterate over all available scaling methods and select the one with the highest 
estimated effectiveness.  
 Click the OK button to confirm the modification and close the Generate class 

bounds window. The updated lower bounds and upper bounds for all classes are 
displayed in the table of the Legend editor dialog window. Note that the labels in the 
table will not be updated. 

 

To manually edit labels for the numeric legend: 
For the numeric legend, it is best first to edit the class bound and then to edit labels 
and colours. 
 Double-click on the label of the class of interest to manually adjust its name. 
 

 
 

To generate labels: 
You can also create labels in the same format for all classes.  
 Click on the Generate labels button. The Generate labels window opens.  
 Select the desired format from the dropdown list next to Format.  
 Define the number of decimals for the label in the text box next to Decimals.  
 If you want to display a unit in the label, select the check box in front of Add unit to 

labels and enter the unit in the text box.  
 Press the OK button to confirm update the labels displayed in the table. 
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To edit width of links or nodes for network layers: 
You can edit the width of links or nodes for the network layer map. The road network 
map is used as an example of working with legend editor for the network layer map. 
 Go to Drivers → Policy measures → Driver Infrastructure. 
 Click the Transport network from the dropdown list next to Network. 
 Click the Show/Edit network at time… button and select the year of interest and 

click OK button. The transport network for the selected year appears in the opened 
map window. 

 Click on the Link width tab in the legend pane. 
 Click on one of the classes to open the Legend editor dialog window.  
 Click on the cell in the Width column for the class of interest to open the Choose 

line width dialog window. 
 Click on the up/down spin buttons to select the line width of interest for the selected 

class.  
 Press the OK button to confirm the change you made on the width for the selected 

class. 
 

 
 

To save changes made in the legend editor: 
 Press the OK button in the Legend editor dialog window to confirm and save 

changes you made for the legend.  

2.3.3 Graph 

The graph editor is used extensively in WISE to define two-dimensional relations: time 
series and distance decay functions. At the left side of the graph editor window is graph 
display area. To the right is x/y value pairs list, showing you the x/y value of the graph. 
In general, except for the neighbourhood influence graph (see the section Land use 
change model), the graphs in WISE can be edited both in the Graph display area part 
which is indicated with the white background and it can also be edited in the X/Y value 
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pairs list part. Changes made in one of two parts will be immediately visible in the other 
part. 
 
In the current version of WISE, for the editable graphs, we apply a linear interpolation 
between different points. This means that when you add or change the value of one 
point WISE will automatically interpolate between this point and its neighbour points. 

 
 
You can change a graph by entering points in the graph display area.  
 Move the mouse pointer to the abscissa position for which you want to enter a new 

(ordinate) value.  
 Double-click to add a point to the graph. 
 
As a result a little circle will be drawn and line segments will connect the new point to 
the nearest points left and right in the graph created thus far. There are two ways to 
reposition a point in the graph display area: 
 Left-click the point in the graph display area. Hold the mouse button down while 

dragging it to its new position. Then release the button. 
 Move the mouse pointer to the point that you want to reposition and right-click. The 

Edit point dialog window opens where you can enter the abscissa (x) and ordinate 
(y) values. 

 

 
 
The range of X within which you can choose is indicated on the bottom of the Edit point 
dialog window. If the value of X that you give is out of this range, one error message 
will appear to remind you enter the correct value. For the first and the last points on the 
graph, only the Y value is editable. 
 
You can remove a point again from the graph as follows: 
 Double-click the point on the graph. 
 
You can also reposition a point in the X/Y value pairs list area.  
 Double-click the value in the X/Y value pairs list with known x and y coordinates. 

The Edit point dialog window open s where you can enter the abscissa (x) and 
ordinate (y) values.  

 
You can change the range of the x- and y-axis as follows. 
 Click the Options button at the bottom of the window. The Options dialog window 

opens. 
 Enter the new value for the lower and upper bounds of the x- and y-axis. 
 

Graph display area X/Y value pairs list 
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Additionally you can check the box next to Grid to show grids in the graph display area. 
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2.3.4 Single value 

WISE permits you to edit the single value in the text box through the graphic user 
interface. Here is one example of how to edit single value. 
 Go to Main window → Drivers → Parameters → Hydrology → Parameters.  
 Move the mouse point on the text box next to the variable Bare Surfaces you want 

to edit. The text box becomes editable. 
 Enter a new numerical value in the editable text box. 
 

 

2.3.5 Date and time for map file 

Dynamic changes over time are considered explicitly in WISE. Therefore, maps for 
specific point in time are used as input in certain models (Climate model, land use 
change model and terrestrial biodiversity model) in WISE. Here is one example of how 
to edit date and time for map files at this specified date and time (see the section Map 
file).  
 

Text box 
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 Go to Main window → Drivers → Parameters → Land use → Land use tab → Land 

use changes section. 
 Click the Add time… button. The Enter date and time dialog window opens. 
 Left-click the text box. The text box becomes editable. 
 Enter or edit a date and time in the text box, for instance, 2008-Jan-01 00:00:00. 
 Click OK. 

 
 

Then a line with the new added date is displayed on the list as depicted in figure below. 
Now you can introduce the map file for this new added date by clicking on the browse 
button on the right side. For more information, see the section Map file. 
 

 

2.3.6 Table 

The table editor enables you to enter a series of numerical values. You can the 
keyboard shortcuts Ctrl+c and Ctrl+v to copy and paste selected numerical values from 
the table in WISE to an Excel sheet or vice versa  
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2.3.7 Map file 

The map file editor lets you add or change maps at a specific date and time. To enter 
the date and time, see the section Date and time for map file. 
 

 
 
Before loading a map file, the status of the file is “No file selected” which is displayed 
as “-” in the File column. You can add a land use change for the year 2008. For 
instance, when the land use change for the year 2008 is presented in the file 
lu_change_2008.asc that you prepared and stored in advance: 
 Repeat the action steps described in the section Date and time for map file. 
 Left-click the Browse button in the row 2008-Jan-01 in the table. The Select dialog 

window opens. 
 Navigate to the folder where you put the file lu_change_2008.asc. 
 Double-click lu_change_2008.asc or left click lu_change_2008.asc and press the 

Open button. 

No file selected 
Browse button 

Map file directory 
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Once the map file has been loaded, the directory of this map file is shown in the file 
status cell. You can delete one land use change map on the Map file list again. 
 Click the land use change file that you want to delete. The path of the selected file 

is highlighted with blue background. 
 Press the Remove time… button on the right side. One message window appears 

to ask you whether or not to delete the selected land use change. 
 Press the Yes button on the message window. 
 

 
 
Once the map file has been deleted, this file and its time will disappear from the list. 

2.3.8 Editable map 

The WISE system allows you to edit some maps in the map window of the system, 
such as the maps used in the hydrology model, the initial land use map, suitability 
maps, zoning maps, the river network map and the transport network map. These 
maps are so-called editable maps. There are two ways to see whether a map is 
editable or not.  
 Open your map of interest in a map window.  
 Select your map of interest in the layer manager pane on the top-right side of the 

map window. It is highlighted with blue background. 
 Go to the legend pane on the top-left of the map window. If the radio buttons shown 

in front of the legend, the selected map is editable.  
 Or go to the tool pane on the bottom-right of the map window. If the tool buttons 

under Grid tools are enabled, the selected map is editable. 
 
In this section, we use the initial land use map as an example. It is recommended 
however to edit your map in a GIS package for the sake of accuracy. You can use this 
example for the purpose of practising however 
 

 
 Go to Main window → Drivers → Parameters → Land use → Land use tab → Input 

part. 
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 Click the Show/Edit… button. The Initial land use map window opens. 
 
You can view or edit the initial land use map via the map window. For more information 
about how to use the Grid tools to edit the raster map in the map window, see the 
section Grid tools. For more information about how to use the Network tools to edit the 
network map in the map window, see the section Network tools. 
 

 
 
 Change the initial land use map with the tools under Grid tools. 
 Close the Initial land use map window. One message window appears to ask you 

whether or not save changes you made. 
 

 
 
 Press the No button to cancel saving changes you made. 

 
 
 Press the Yes button to save the changes you made. The Save map „Initial land 

use map‟ dialog window opens where you can save the changed map under a new 
name with its extension. It is strongly recommend entering a new name for the 
changed map so that you can always find the original map coming with the 
software; else, it will be overwritten. 
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2.4 Saving changes 

The previous section Editing Input and displaying output describes how to edit the input 
in WISE. This section describes how to save changes that you made in WISE. As it is 
mentioned in the section Project file, integrated scenario and sub-scenario, input 
data/files and parameters which are required to run models are stored in the project 
file. 

 The set of values that you changed for each driver in WISE will be saved in the 
corresponding sub-scenario. For example, sub-scenarios for high, medium and low 
GDP growth could be defined for the economic model. In parallel, high and low 
population growth sub-scenarios can be defined for the population model. 

 The sub-scenarios that you defined can be combined as a new integrated scenario. 

 The integrated scenario/scenarios that you defined can be saved in one project file 
with the extension *.geoproj. 

 Alternatively the changes and combinations that you defined can be saved in 
different project files. 

 
The description above seems very complicated. However, the convenience of the user 
has been taken into account in WISE for the saving of changes. Therefore, saving a 
sub-scenario, saving an integrated scenario implies simply saving a project file. 
The WISE system also considers changes that have been made even though you 
didn‟t change any value, for example when you press the OK button in an editable 
graph dialog window.  

2.4.1 Save a project file 

The Save project command on the File menu allows you to save changes to data/files 
and parameter values and to save the simulation output for the current simulation year 
in the current project file. The action of saving a project file includes saving sub-
scenarios, saving an integrated scenario and saving external files.  
 
The following sub-sections describe how to complete an action of saving a project file 
with the same name of the current project file. The steps are: 

 Open an existing project file 

 Select an integrated scenario as the active integrated scenario. 

 Modify population and economic parameters in the external factors section. 

 Save the sub-scenarios for the economy driver and population driver as new sub 
scenarios in the external factors section. 

 Save a new integrated scenario “Growth”, which inherently includes the newly 
defined sub-scenarios. 

 Save the external files. 

 Save the complete project file.. 
 
First of all, change 2 parameters in economic scenario and population scenario:  
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 Select the Baseline as the active integrated scenario by clicking on the dropdown 
list next to Integrated scenario on the toolbar. 

 Go to Main window → Drivers → External factors → Population section. 
 Click the graph icon next to the Fertility lever. The Fertility Lever window opens. 
 Increase the value for 2050 by right-clicking on the point for 2050 and enter the new 

value in the text box next to Y. Press OK. 
 Go to Main window → Drivers → External factors → Economy section. 
 Click the dropdown list next to Interregional exports in sector. Click Dairy cattle 

farming. The International exports in Dairy cattle farming window opens. 
 Increase the value for 2050 by right-clicking on the point for 2050 and enter the new 

value in the text box next to Y. Press OK. 
 
Now you are ready to save changes that you made to the 2 parameters. The 
operations of saving sub-scenarios, saving an integrated scenario and saving a project 
file can be done in the same dialog window.  
 Click the Save project command on the File menu. The Save project dialog window 

opens. 
 
The figure depicted below shows the dialog window on the Scenario tab. On the top of 
the window, the area in the red frame is the Integrated scenario pane. On the lower 
part of the window, the area in the green frame is the Sub-scenario pane. 
 

 

2.4.2 Saving sub-scenarios 

First of all, we explore the actions related to saving sub-scenarios. The Sub-scenario 
pane part allows you to give a name and description for the sub-scenario that have 
been changed. The options available in the dropdown list for each driver can differ 
based on the state of the system and the characteristics of the active sub-scenario as 
listed in table below.  
 

Integrated scenario pane 

Sub-scenario pane 
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Option Available if no values 
in the driver have 
been changed 

Available if changes 
have been made and 
the active sub-
scenario is read-only 

Available if changes 
have been made and 
the active sub-
scenario is writable 

(No changes) X   

Copy to new 
scenario 

X   

Discard changes  X X 

Save as new 
scenario 

 X X 

Save in active 
scenario 

  X 

 

 The name of each active sub-scenario is displayed in the text box next to Name. 

 If the Copy to new scenario option or the Save as new scenario option is selected, 
the Details… button becomes enabled and the text box next to Name becomes 
empty. You can add a name and a description for the new sub-scenario in the 
Scenario details dialog window by clicking. on the Details… button. 

 If the No changes option, Discard changes option or Save in active scenario option 
is selected, the name of the active sub-scenario is displayed. 

 
The new sub-scenario name that you give for the specific driver should be a unique 
sub-scenario name. For example, if you enter a “Baseline” sub-scenario name for the 
Population driver in the Scenario details dialog window, one error message appears to 
remind you that it already exists. The same word in different letter case is considered 
as different names. For example, if the “Baseline” already exists, it is still possible to 
enter “baseline” as a new sub-scenario name. 
 
With this layout, the most important information is captured in one screen and details 
are hidden behind buttons. 
 

Options Description 

(No changes) No input data/files and parameters in the sub-scenario of the 
corresponding model have been changed. 

Copy to new 
scenario 

Copy input data/files and parameters in the sub-scenario of the 
corresponding model to a new sub-scenario. Add the name and 
description for the new sub-scenario by clicking the Details... button. 

Discard changes Cancel changes made to the input data/files and parameters in the sub-
scenario of the corresponding model. 

Save as new 
scenario 

Save changes made to the input data/files and parameters in the sub-
scenario of the corresponding model to a new sub-scenario. Add the 
name and description for the new sub-scenario by clicking the Details... 
button. 

Save in active 
scenario?? 

Save changes made to input data/files and parameters in the sub-
scenario for the corresponding model to the active sub-scenario. The 
active sub-scenario will be overwritten with changes you made. 

 
You can define the new sub-scenarios according to changes you made in the previous 
steps. 
 Click the Details... button next to on the right side of the External factors - 

Population scenario raw. The Scenario details dialog window opens. 
 Enter a new scenario name “Population growth” in the text box next to Name. 
 Enter the description text in the text box next to Description. 
 Click OK at the bottom of the Scenario details dialog window. 
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 Repeat the same steps for the External factors – Economy scenario.  
 
The name of the sub-scenario Population growth is displayed in the External factors - 
Population scenario row and Economic growth is displayed in the External factors – 
Economy scenario row. The active sub-scenarios Baseline for the other drivers 
remains unchanged since the last time it was saved. 
 

 

2.4.3 Saving an integrated scenario 

The Integrated scenario pane part allows you to create a new integrated scenario and 
add its name and description on the base of the all available sub-scenarios. You can 
define a new integrated scenario as follows. 
 Enter a new integrated scenario name Growth in the text box next to Integrated 

scenario name. 
 Enter a description in the text box next to Integrated scenario description to 

describe the new integrated scenario. 
 Check whether the combination of sub-scenarios in the Sub-scenario pane is 

correct.  
 If you have checked the External files, click the Save button at the bottom of the 

Save simulation window to save both the definition of the integrated scenario and 
sub-scenarios on the Scenario tab and the files in the External files tab. 

 
Similarly the sub-scenarios, names for new integrated scenarios should be unique in 
that project file. When you enter an integrated scenario name which already exists, for 
example, “Baseline”, an error message will appear to remind you that it already exists. 
The same name in different letter case is considered as different names. For example, 
if the “Baseline” already exists, it is still possible to enter “baseline” as a new integrated 
scenario name. 
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For more information of saving external files, see the next sub-section Saving external 
files. You can also click the Reset button to reset changes that you made in the Save 
simulation window. You can click the Cancel button to cancel the action of saving 
simulation.  

2.4.4 Saving external files 

The project file contains parameters and references to all data files that are required to 
run models in the system and the simulated results for the current simulation year. All 
data files that are used as input and output for the current simulation year in the system 
are so-called External files.  
 
Saving changes includes saving external files besides saving the integrated scenario 
and sub-scenarios.  
 Click the External files tab on the Save project dialog window. The dialog window 

depicted as in the figure below appears. 
 
The External files tab of the Save project dialog window shows an overview of all input 
data files are used and the output data/map files for the current simulation year in the 
current project file and their respective names and paths. 
 

 
 
If you are a relatively new user of WISE, press the Save button to complete saving the 
project file and skip the remainder of this section. However, if you are more 
experienced with the system, this dialog window will help you to change the 
composition of your project file before saving it.  

 Keeping the same directories and file names for all data/map files: If you press the 
Save button in the Save project dialog window, the file that has not been changed 
will be saved in the default directory which is configured in the current project file; 
the file that has been changed will be saved in the directories which is configured 
after its modification. 

 

 Changing the directory or the file name of each data file: The directory of each 
external file displays in the cell of the File name column. The system allows you to 
specify the directory where you want to save each data file: by left-clicking on the 
path name in the cell of the File Name column. Once it is selected and marked 
blue, you can type any path or file name you want. The system allows you to 

change the format of data file by clicking  and selecting the appropriate data type 
from the dropdown list. You can also specify the directory and the file name of each 
data file by clicking the browse button and navigating to the location you want to 
save and giving a new name for it. 
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 No file: The data file marked as “-” on the File name list indicates this file is not 
used or not required for the current simulation.  

 

 You can always use the Reset to undo the changes in the table before you click the 
Save button. 

 
Once you press the Save button of the Save project dialog window, the current project 
file will be overwritten, and the original information will be lost. Overwriting files can be 
avoided simply by choosing another file name than the current one (see the section 
Save a project file as). 
 
The intermediate results will not be saved through the External files tab. To save these, 
you should make use of the Write to Excel… command, the Log maps… command and 
the Animate maps… commands from the Options menu. You will find more information 
on these in sections Write to Excel, Log maps, Animate maps, respectively. 

2.4.5 Save a project file as 

The Save project as… command on the File menu allows you to save the changes to 
data/files and parameter values and to save the simulation output for the current 
simulation year with another project file name. The same as saving project, the action 
of saving project as will be completed by the combination of saving sub-scenarios, 
saving an integrated scenario and saving external files.  
 
For this example, you can continue working on the Waikato.geoproj which has Baseline 
and Growth integrated scenarios available by importing a network change for the year 
2008. 
 Open Waikato.geoproj in WISE (see the section Opening an existing project ). 
 Select Baseline integrated scenario as the active integrated scenario by clicking on 

Baseline on the dropdown list next to Scenario on the toolbar. 
 Go to Main window → Drivers → Policy measures. 
 Select Infrastructure from the dropdown list next to Driver. 
 Select Transport network from the dropdown list next to Network. 
 Click Import network change… button. The Import network change dialog window 

opens. 
 Select 2010 from the dropdown list next to Time.  
 Click the checkbox next to Incremental. 
 Click the browse button next to File. The Open network change layer dialog window 

opens. 
 Select the network change for 2010 that you want to upload and click the Open 

button in the Open network change layer dialog window. 
 Click the OK button in the Import network change dialog window. 
 

 
 
Now, you import the incremental network change for 2010. 
 Click the Save project as… on the File menu. The Save project file dialog window 

opens. 
 Enter a new project file name Waikato_NetworkChanged.geoproj.  
 Press the Save button on the Save project dialog window. The Save project dialog 

window opens. 
 Specify the integrated scenario as Network_Changed in the integrated scenario 

pane. 
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 Specify the Policy measures – Infrastructure scenario as Network_change_2010 in 
the sub-scenario pane. Press OK in the Scenario details dialog window. 

 

 
 
You can specify the external files via the External files tab. 
 Click the External files tab. 
 Move the mouse to the Network part in the File name column and verify the path 

and file name for the NetworkDeltas_2010_0_network. 
 
You will also see the Network change for 2010 is appeared on the list. The tooltip box 
shows the whole path and the file name. 
 

 
 
For more information, see the section Saving external files. 
 Press the Save the button at the bottom of Save project dialog window to finalize 

saving project file as Waikato_NetworkChanged.geoproj. 
 
You will see the Waikato_NetworkChanged displaying on the top-left of the Geonamica 
window. 

2.5 Running a scenario 

Once the Main window and the Land use map window have been opened, the program 
has read the default values for all the parameters as well as the initial values for all the 
state variables of models. The program is ready to run a scenario. You can run a 
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scenario with the control buttons on the toolbar or with the commands on the 
Simulation menu. 
 

 

 
 
On the toolbar as depicted in the figure above, the left-most box displays the active 
integrated scenario. The right-most box displays the Simulation clock, which indicates 
the progress of the simulation: the year until which the simulation has run. The initial 
year is 2006 in WISE. 

2.5.1 Active integrated scenario 

Before you start running the simulation, you need first to select one integrated scenario 
as the active integrated scenario. 
 Click the dropdown list next to Integrated Scenario on the toolbar. All the available 

integrated scenarios will be displayed on the list. 
 Select your integrated scenario of interest from the list, for example, the Baseline 

integrated scenario. 
 
After you select the integrated scenario from the list, the system loads the integrated 
scenario immediately as the active integrated scenario. When collapsed, the list box 
shows the name of the active integrated scenario. You can easily switch to another 
integrated scenario from the active integrated scenario dropdown list on the toolbar. 
For example, the current active integrated scenario is the predefined Baseline 
integrated scenario, no change has been made and you want to switch to the Growth 
integrated scenario.  
 Click Growth on the dropdown list next to Integrated Scenario, the Growth 

integrated scenario is displayed on the list.  
 
The Growth integrated scenario is now loaded by the system. 
However, if you made changes to the input data/files and parameters of the current 
active integrated scenario you need to save them first. For instance you want to switch 
to the Growth integrated scenario as the active integrated scenario from the Baseline 
integrated scenario. 
 Click Growth on the dropdown list next to Integrated Scenario, the Growth 

integrated scenario is displayed on the list.  
 
A message window as depicted in the figure below appears to ask you whether or not 
to save changes that you made in the active scenario. 
 

 
 Click the Cancel button to cancel the action to switch Growth integrated scenario as 

the active integrated scenario. 
 

Active integrated scenario Simulation clock 
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 Click the No button to discard changes you made in the active integrated scenario. 
Then the system will load the Growth integrated scenario as the active integrated 
scenario. 

 

 Click the Yes button to save changes you made in the active integrated scenario. 
The Baseline integrated scenario is displayed on the dropdown list on the toolbar 
and the Save project dialog window opens where you can determine how to save 
changes you made. For more information, see the section Saving changes. After 
you save the changes in a new integrated scenario via the Save project dialog 
window, the new created integrated scenario becomes the active integrated 
scenario automatically on the dropdown list on the toolbar. 

 
Note that loading the active integrated scenario means loading the input data/files and 
parameters defined in this integrated scenario to the graphic user interface. In this 
case, the models have not been updated to the changes. You can use the Update, 
Step, Run and Reset command to update the models of the system to the changes. 

2.5.2 Reset 

You can switch the simulation clock back to the start year of the simulation by pressing 
the Reset button on the toolbar or by using the Reset command on the Simulation 
menu. This action resets all the parameters and maps to their initial value. The 
changes that you made to the parameters and maps, which include the changes to the 
initial values and initial maps, are affected by resetting the simulation because all of 
them are recalculated for the start year.  
 
Whenever you change the initial values or initial maps for the start year, you need to 
reset to perform the changes. 

2.5.3 Update 

To update the models of the system to the changes that you made in the user interface 
for the current simulation year (hence, except for the changes to the initial values or 
initial maps), you can use the Update command on the Simulation menu. The action of 
updating will not take into account the changes that you made to initial values or initial 
maps. To that effect, you can use Reset or click the Step or Run button on the toolbar. 
After the model has been updated, the variables that are affected by changes are 
recalculated and the updated output will be displayed via the user interface.  
 
You can use the Update command to have the model perform the changes that you 
made without advancing the simulation clock. This is especially useful to test the 
immediate effects of a newly entered (set of) parameter(s) before running the 
simulation. 

2.5.4 Step 

To verify that the program is ready to run, you can use the Step command on the 
Simulation menu or press the Step button on the toolbar. Once pressed, WISE goes 
through a number of essential phases, such as the updating the models and testing of 
its input, which are of no direct interest to the user before it makes one simulation time 
step. This takes a while. You will notice that the action is finished when the simulation 
clock changes to next simulation year and the land use map in the Land use map 
window is updated. If you select the Step command, the models will be automatically 
updated if this has not been done manually. 

2.5.5 Run 

To perform a simulation for the whole simulation period, you can use the Run 
command on the Simulation menu or press the Run button on the toolbar. The 
simulation starts running until the next pause moment has been reached and the 
progress can be followed as the Land use map window and the simulation progress 
clock are updated on a yearly basis. 
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Unless other pauses are set (see the section Pauses), the simulation will halt at the 
end of the simulation period. If you select the Run command the models of the system 
will be automatically updated if this has not been done manually. 

2.5.6 Stop 

You can pause a running simulation by pressing the Stop button on the toolbar or using 
the Stop command on the Simulation menu. When the simulation is stopped, it finishes 
the calculations for the current simulation year and stops. The simulation continues 
when you select the Step or Run. You can also pause the simulation at predefined 
instances (see the section Pauses). 

2.5.7 Pauses 

To set the pauses in the simulation, you can use the Pauses… command on the 
Simulation menu. When Pauses… is selected, the Pause Settings dialog window 
opens. You can use the Run command on the Simulation menu or press the Run 
button on the toolbar to advance the simulation again until the next pause is reached. 
 

 

2.5.7.1 Display format 

In the Display format pane of the Pause settings window, you can define the display 
format of pause tabs by clicking the radio button in front of the format that you want to 
display. When you switch the format, the list of pauses is displayed accordingly.  
 
Be aware that the Display format that you defined in the Pause settings dialog window 
will be used for the integrated time in the system, such as the time format in the Log 
maps on the Options menu and Simulation clock on the toolbar. 
 

 

2.5.7.2 Add and remove 

You can add a new pause by clicking the Add button on the top-right of the Pause 
Settings dialog window. Enter the year in which you want to halt the simulation in the 
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text box next to Time and then press OK. The pause at this year will be added to the 
Pauses list. 

 
 
You can remove a pause by selecting the one that you want to remove and clicking the 
Remove button on the right hand side of the Pause settings window. 

2.5.7.3 Generate 

You can predefine pause instances by using the Generate command. The Generate 
pauses dialog window opens when you press the Generate button of the Pause 
settings window. You can enter the interval start time, the interval end time and the 
interval step length in the Generate pauses dialog window and press OK button. The 
pauses are generated and displayed on the pauses list of the Pause Settings dialog 
window. 
 

 

 
 

2.6 Saving results 

2.6.1 Write to Excel 

You can select the Write to Excel… from the Options menu to establish (or interrupt) a 
link between WISE and a Microsoft Excel workbook. A new window appears as shown 
below. WISE is sending model output to the Excel Workbook while the simulation is 
advancing.  
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The data transferred to the Excel workbook shows results for the Economic model, 
Population model and Terrestrial biodiversity model.  

2.6.1.1 Defining Excel sheet name 

The list of predefined output options are displayed per model block from which they 
origin in the Model block name column on the top pane of the Write to Excel settings 
window. The system will only make links for the model blocks which are configured in 
the column of Excel sheet name.  
 Select the cell next to this model block to enter a name by clicking on it. 
 
If you want to use the model block as the Excel sheet name, you can use Ctrl+c and 
Ctrl+v on your keyboard to do so. 
 Click on the model block name for which you want to make link to Excel sheet. 
 Press Ctrl+c on your keyboard. 
 Click the corresponding cell in the column of Excel sheet name.  
 Press Ctrl+v on your keyboard. 
 
The names that you add in the Write to Excel settings window will be displayed as the 
names of the sheets in Excel. 

 

2.6.1.2 Defining writing moments 

While a simulation is advancing, the system only writes model output for the moments 
that are determined in the Writing moments pane on the lower-left part of the Write to 



 

WRC Doc # 2012288 Page 44 

Excel settings window. You can adjust the list of writing moments by using the Add… 
button, the Generate… button, the Delete button and the Reset button. 
 
You can add a single moment as follows. 
 Click the Add… button. The Add write moment dialog window opens. 
 Enter the moment in the text box next to Time for which you want to display the 

model output in the Excel workbook. 
 Press OK.  
 
The write moment at this year will be displayed on the Writing moments list 
immediately. 
 

 
You can define write moments at regular intervals as follows: 
 Click the Generate… button. The Generate moments dialog window opens. 
 Enter the interval start time, the interval end time and the interval step length in the 

Generate moments dialog window. 
 Press OK.  
 
The moments are generated and displayed on the Writing moments list immediately. 

 

 
 
You can easily delete one or several writing moments by selecting the moments that 
you want to remove and clicking the Delete button. If you are not satisfied with the 
moments that you just created, you can undo the configuration by clicking the Reset 
button. This action will reset all writing moments to the value they had when you last 
opened the Write to Excel settings window. 

2.6.1.3 Starting writing 

To finalise the link between WISE and Excel workbook, you can click the Start writing 
button on the right-low pane of the Write to Excel settings window. The Write to Excel 
settings window closes automatically. A link between WISE and Excel workbook is 
established after this action, although you cannot see this directly on your screen.  

 
 
While this function is activated, Write to Excel on the Options menu is preceded with a 
tick mark.  
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Now you can run the simulation with the link to the Excel by clicking the Run button on 
the toolbar. Note that the system only starts writing results to Excel from the first writing 
moments after the current simulation year. For example, if the current simulation year 
is 2010, you press the Start writing button and then press the Run button. The first 
writing moment will be the year 2011 which is the first writing moments after the current 
simulation year (2010) as depicted in the figure below. 
 

 
 
If you want to write results to Excel from the start year of the simulation after setting the 
writing moments, you can follow the steps below. 
 Click the Start writing button of the Write to Excel settings dialog window. 
 Click the Reset button on the toolbar. 
 Click the Run button on the toolbar. 

2.6.1.4 Saving settings  

You can change settings for writing to Excel while the simulation is running.  
 Click the marked Write to Excel option on the Options menu.  
 
The Write to Excel settings window opens again. Now the Save settings, and the Open 
Excel workbook buttons become enabled on the right-low pane of the window. You can 
only change the settings of in the Writing moments but you cannot change settings in 
the Excel sheet name pane that are greyed-out.  
 

 
 
It is very important to press the Save settings button to finish the adjustments while 
keeping the system writing model output to the Excel workbook. Only the data for 
moments, which are later than the current simulated time, will be written to the Excel 
workbook. The function of Write to Excel on the Options menu is still preceded with a 
tick mark.  
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If you press the Open Excel workbook button, the function of Write to Excel will be 
switched off. You can always check whether the link to Excel is activated from the tick 
mark Write to Excel on the Options menu. 

2.6.1.5 Opening Excel workbook 

To stop writing to Excel and view the Excel workbook, you can press the Open Excel 
workbook button. The Excel workbook opens immediately, showing the worksheets 
with the names that you defined. You can use it now for further analysis of the 
simulation data. 
 

 
 
Note that in order to establish a successful link, it is required that Excel is installed on 
your computer. If WISE cannot find Excel, the Write to Excel on the Options menu will 
be greyed out.  

2.6.2 Log maps 

You can use the Log maps… command on the Options menu to store all the maps 
produced by the system in the form of .rst files. The system generates a Log File (*.log) 
automatically when you use the Log maps… command. In the Log File, all the maps 
that you selected to log are included.  
You can analyse these logged maps files *.log with the Map Comparison Kit – see the 
section Analysing spatial results. 
 
When Log maps…command is selected the Log settings dialog window opens. 
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2.6.2.1 Selecting maps 

In the Maps to log pane, a tree of maps is available, which is organized by the type of 
information on the map. You can expand or collapse the branches of map tree by 
moving the mouse over the name of group and double-click or moving the mouse over 
the box in front of the group and left-click.  
 
In this tree, you can indicate which maps you want to store. You could select/unselect 
all maps in a sub-model – e.g. all accessibility maps or all maps in the land use model 
– or in the entire model by clicking on the corresponding check box. 
 Click the check box on the left side of the name of the map that you want to log.  
 
Maps are selected for logging if the check box is checked with a green mark. 

2.6.2.2 Defining path and file names 

The WISE system will generate a log file with the extension .log containing the logged 
maps. You could specify the path and the name of the log file in the text box next to 
MCK log file. In the example as depicted below, the file Waikato.log is the MCK log file. 
You can double click this log file to open it and to load the logged maps into the MCK. 
For more information, see the section Analysing spatial results. 
 
In the text box next to Simulation name, you need to enter a descriptive name that can 
represent the simulation you are going to run. The logged maps will be stored in the 
folder named with the Simulation name you specified. And the folder named with the 
simulation name will be stored under the folder named with the sub-model you selected 
in the previous step Selecting maps. You can select Year, Date or Date and time from 
the dropdown list next to Time format. The selected time format will be used as part of 
the names for the logged maps.  
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In the example as depicted above, the selected maps to log are land use maps under 
the Land use sub-model and the threatened environments maps under the Biodiversity 
sub-model. Then the logged land use maps will be stored in the folder under 
\Geonamica\WISE\Log\Land_use\Baseline. The logged habitat fragmentation maps will 
be stored in the folder under \Geonamica\WISE\Log\Biodiversity. 
 
Besides to specify the path and the log file name, it is important to give a different and 
descriptive name for the Simulation name based on the scenario or simulation that you 
are running. Otherwise, previously logged maps will be overwritten. 
 
You can modify the path and the name of the log file as follows: 
 Click the browse button on the right side of the text box. The Select MCK log file 

window opens.  
 Navigate to the location that you want to store the logged maps and click the Open 

button.  
 Enter the name of the log file next to File name.  
 Press the Save button. 
 
If you are using an existing log file name, new logged maps will be added to the same 
log file which has already included logged maps from previous simulation runs. If the 
same simulation name is used, the logged maps in the folder named with the 
simulation name will be overwritten. 
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2.6.2.3 Editing log moments 

In the Log moments pane on the lower-left part of the Log settings window, you can 
specify moments for which maps will be logged. First of all, you can select the time 
format used in the file names of the logged maps from a number of presets, including 
the year, the full date and the full date and time. To do so, select the format of interest 
from the dropdown list next to Time format. 
 
You can make a list of logging moments by using the Add…button, the Generate… 
button, the Delete button and the Reset button of the Log moments pane. This works 
similarly to Defining writing moments in the Write to Excel.  
 
The system allows you to change the display format on the Add log moment and 
Generate log moments dialog windows by using the Pauses…command in the 
Simulation menu (see the section Pauses). You can change the settings in the Maps to 
log pane and the settings of in the Log moments pane while the simulation is still 
advancing.  

2.6.2.4 Turning logging on 

To activate the logging functions, you have to press the Turn logging on button on the 
lower-right pane of the Log settings dialog window. The selected maps in the tree of 
maps will be stored in the path you specified. The function of Log maps in the Options 
menu is preceded with a mark. 
 

 
 
If there is no map selected, you are not able to turn the logging function on. A message 
window depicted as figure below appears. 
 

 

2.6.2.5 Saving settings 

You can finish any adjustments made in the log settings by clicking the Save settings 
button. Only the maps for the moments, which are later than the current simulated time, 
will be logged. The function of Log maps on the Options menu is still indicated with a 
tick mark when it is activated.  
 
When the function of log maps is enabled, the selected maps for the selected log 
moments will be logged while the simulation is running. 
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2.6.2.6 Turning logging off 

You can stop the logging by clicking the Turn logging off button on the lower right pane 
of the Log settings dialog window. The function of Log maps on the Options menu is 
now displayed without a tick mark. 
 

 
 
You can also let the system turn logging off automatically after the last log moment. To 
do so,  
 Click the check box in front of Turn logging off after last log moment at the bottom 

of the dialog window. 

2.6.3 Animate maps 

It is also possible to make movies of maps during a simulation and store them for later 
use. To that effect, you can use the Animate maps… command from the Options 
menu. When this command is selected the Animation settings dialog window opens. 
Animations are stored in the form of .gif files. 
 

 

2.6.3.1 Selecting maps 

In the Maps to animate pane, a tree of maps is available, which is organized in groups 
with information on the map including raster maps and vector maps. You can expand 
or collapse the branches of map tree by moving the mouse over the name of group and 
double-click or moving the mouse over the box in front of the group and left-click.  
 
In this tree, you can indicate which maps you want to store. You can select/unselect all 
maps in a sub-model – e.g. all accessibility maps or all maps in the land use model – or 
in the entire model by clicking on the corresponding check box. 
 Click the check box on the left side of the name of the map that you want to 

animate.  
 
Maps are selected for animation when the check box is checked with a green mark. 

2.6.3.2 Changing path of animation maps 

The program automatically sets the location where the animations are stored as well as 
the file name in the Animation directory text box. You can change the filename and 
location by pressing the browser button on the right hand side.  
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When the Animate maps function is activated in WISE, this is indicated with a mark in 
front of this option on the Options menu. If no map is selected in the Animation settings 
dialog window, no animations will be generated during the simulation.  
 

 

2.6.3.3 Animation size 

When animating maps, the maps are transformed into an image (the animations are a 
number of images glued together into one file). The title on the animation will be 
displayed with fixed pixels. In the Animation size pane, you can choose the appropriate 
option among Screen, Actual size and Custom options. 

 Screen (800x600): the animation will be rescaled according to the normal screen 
size, which is of width 800 pixels and height 600 pixels. It is recommended to 
choose this option if you want to make an animation movie for a presentation. The 
title is always readable in this case.  

 Actual size: the animation will be the actual size of the map. In another words, one 
cell on the map is displayed as one pixel on the animation. 

 Custom: the animation will be rescaled according to the specified height and 
weight. You can specify the height and width of generated animations by entering 
the values in the text boxes next to Custom. 

 
The aspect ratios of the animated maps will remain constant when maps are rescaled 
to fit the image size.  
 
You can view the animations in most recent Internet browsers as well as some 
graphics packages equipped with an animation facility. 

2.7 Analysing results 

The Map Comparison Kit (MCK) is a stand alone software tool that includes a number 
of algorithms that you can use to analyse your results The WISE can open the MCK to 
analyse results as follows:  
 Go to Main window → Analysis → Map Comparison. 
 Click the Start MCK button in the content pane of the Main window. The Open 

dialog window opens in the Map Comparison Kit. If you do not have the MCK 
installed on you computer. You can click on the links to download it for free. 

 

 
 
In the Open dialog window, the ###.log file generated in WISE is the default log file. For 
more information, see the section Log maps. 
 
The MCK comes with its own dedicated manual which is delivered as an integral part of 
the WISE package. It explains the use of the MCK and describes in detail how you can 
analyse and compare logged maps generated by WISE in an interactive manner. All 
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logged maps generated by WISE can be read into the MCK in a straightforward 
manner. 
 
One example about how to use Map Comparison Kit to compare scenarios for Policy 
user is given in the section Analysing results. 
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3 Policy interface 
The user interface of the WISE system provides access for two types of users: the 
policy user who carries out impact assessment studies related to the impact of certain 
policies under a range of external conditions and the modeller, who is responsible for 
the underlying (scientific) information of the system and needs to adapt underlying data 
and parameters when more data or information becomes available over time. 
 
The Main window of WISE provides access for both types of users. The structure of the 
Main window is available in the section Main Window. Here we will first explain how the 
policy user can use the system and then how the modeller can access the models.  
 
The policy user finds access to all information relevant for analysing the impact of 
policies and external factors on the left hand side of the Main window. Information is 
organised in such a way that the user can carry out a structured analysis. It follows the 
steps Drivers, Scenarios, Indicators and Analysis, each of which is explained in more 
detail below.  
 

 

3.1 Overview of the policy interface 

This section gives a brief overview of the steps you can take to carry out a policy 
impact assessment with WISE. In the following sections each step will be explained in 
detail.  
 
When clicking on the Drivers tab in the navigation pane on the left hand side of the 
window you get access to the different types of drivers: External factors, Policy 
measures and Parameters. The first two are part of the policy analysis functionality of 
the system; the latter is the way scientists or modellers can get more detailed access to 
the underlying models, their data and their parameters. Clicking on each of the driver 
type icons opens the settings for this driver or set of drivers in the content pane on the 
right. 
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3.1.1 Step 1: Setting up the drivers 

Drivers incorporated in the system are organised in two groups: External factors and 
Policy measures. When you click on one of these, you get access to the underlying 
information. This is also the entry point for adapting drivers and entering new data. 
 
The result of this step is a set of sub-scenarios for each of the drivers. When 
developing a sub-scenario you can build on existing sub-scenarios which are part of 
the active integrated scenario. For example, if the Baseline integrated scenario is 
selected as the active integrated scenario, for the driver External factors, a Baseline 
sub-scenario for the external factors - population driver is loaded that includes all the 
baseline information about the population. If you want to build on this sub-scenario, you 
simply load the Baseline integrated scenario, make the required changes and save it 
under a different sub-scenario name for the population driver.  
 
Drivers for policy user that are included in WISE are the following:  

 External factors 
- Economy: international exports, interregional exports, gross fixed capital 

formation 
- Population: fertility lever, mortality lever, additional net in-migration for each 

district 
 

 Policy measures 
- Economy: rates of change in land productivity, rates of change in labour force 

productivity 
- Population: proportion of people living in each residential land use category for 

each district 
- Zoning measures 
- Infrastructure 

 
Steps required to view or change driver settings are described in the section Setting up 
the drivers. 

3.1.2 Step 2: Creating integrated scenarios 

In the second step, integrated scenarios can be assembled from a selection of existing 
sub-scenarios. For each of the drivers you need to select one sub-scenario. 
 
When clicking on the Scenario manager icon in the navigation pane of the main 
window you gain access to that part of the interface where you can construct your 
integrated scenarios or upload an existing integrated scenario. Steps required to create 
integrated scenarios are described in the section Creating integrated scenarios. 
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3.1.3 Step 3: Running the simulation 

Obviously you cannot investigate all land use changes, as well as other available 
information, while the system is running. Therefore you have several possibilities to 
export intermediate and final results of the simulation: 

 You can select an individual map and export it to analyse it. 

 You can create logged maps using log maps function which could be analysed 
afterwards in the Map Comparison Kit (part of the WISE package) or common GIS 
packages. 

 You can make an animation that shows you the land use, indicators or other model 
results change over time. You can open the animation in a viewer, but can also 
incorporate them in presentations. 

 You can create a link to Excel through which all selected model block results are 
directly written to Excel. This can be used for analyses and post-processing 
afterwards. 

 
Before running the simulation you can decide which results you would like to save to 
disk. For details about running the simulation and saving results, please refer to the 
section Running a scenario and the section Saving results. 

3.1.4 Step 4: Visualising indicators 

After simulation is finished, WISE offers several options to analyse results. The first 
option is to visualise indicators that are being calculated by the system. The indicators 
are organised in four groups: 

 Social indicators 

 Economic indicators 

 Environmental indicators 

 Land use indicators 
 
On a yearly basis each of these indicators is calculated. Depending on the type of 
indicator, it is calculated at one of the spatial levels (NZ & world, regional, district and 
local) or at several spatial levels. You gain access to the indicators by clicking the 
Indicators icon in the main window. Steps to take in visualising indicators are described 
in the section Visualising indicators. 

3.1.5 Step 5: Analysing results 

The final step of the impact assessment study is to analyse results within an integrated 
scenario (e.g. the temporal evolution of an integrated scenario) or to compare a set of 
integrated scenarios. In step 3 of the assessment you have selected what type of 
information you want to save for analysis. In this step you carry out the analysis 
thereof. The Excel files that have been created can be analysed with Excel; the 
animations can be shown in a viewer; and the logged maps that have been saved in 
log-files that can be opened in the Map Comparison Kit, which can be opened when 
going to the Analysis tab of the Main Window.  

3.2 Setting up the drivers 

In this section you will become familiar with the different drivers in the system and learn 
how to enter and change information related to these drivers. There are 3 sections 
under the Drivers tab: External factors, Policy measures and Parameters. Among them, 
the Parameters section is relevant only to a modeller. The detailed description about 
the Parameters section will be found in the next section Modeller interface. 
 
When you start the system with the project file Waikato.geoproj all baseline data is 
loaded into the system. In the following sections you will learn how to view and change 
the baseline information step by step for each of the drivers in the system. Creating 
new sub-scenarios for the individual drivers can be done in two ways: 

 By building on the baseline information. In this case adaptations are being made to 
the data that comes up when you open Waikato.geoproj. 
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 By building on information in other sub-scenarios. In this case you first have to load 
a sub-scenario for a specific driver and subsequently you can make your 
adaptations to this sub-scenario.  

 
Both options will be shown in the following sections. 

3.2.1 External factors 

For true integration amongst different disciplines, WISE incorporates not only the 
economic model, but also models related to climate change, hydrology, water quality, 
demography, land use and terrestrial biodiversity. In the economic model, some 
parameters are external factors and some are policy measures.  
 

 
 
When you click the External factors icon in the navigation pane on the left hand side of 
the Main window you will see that the content pane on the right hand side of this 
window. The External factors included in the current version of WISE are: 

 Economy 

 Population 
 

 
 
When you have the External factors in front of you, you can carry out the following 
actions: 

 View historic data 

 View scenario data (future assumptions) 

 Adapt historic and scenario data 

 Load an existing sub-scenario 

 Make changes to an existing scenario and save its results 
 
Since the steps are very similar for all external factors we take Population as an 
example to explain how you can work with the external factors. 

3.2.1.1 How to view data and scenario data for the Baseline integrated 
scenario? 

 Select the Baseline integrated scenario as the active integrated scenario from the 
dropdown list on the toolbar. 

 Go to the Driver tab of the Main window. 
 Click the External factors icon. 
 Go to the Population part in the content pane. 
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 Click the graph icon of your interest. For instance, click the graph icon next to 
Fertility lever. The Fertility Lever graph window opens. 

 
This graph shows the fertility lever in percentage on the y-axis and the year on the x-
axis. You can press Cancel to go back to the Main window.  
 

 

3.2.1.2 How to adapt values for external factors? 

 Go to the Driver tab of the Main window. 
 Click the External factors icon.  
 Go to the Population part in the content pane. 
 Click the graph icon next to Fertility lever. A graph window opens that displays the 

female fertility lever between 2006 and 2050. 
 
There are several ways to enter new population figures in the system. The first way is 
to drag the bubbles in the graph to the desired value. You can also enter the precise 
values by clicking on a bubble with your right mouse button or by clicking on a value in 
the list on the right hand side of the window. More bullets can be added by double 
clicking with the mouse in the graph and bubbles can be removed by double clicking 
with the left mouse button on a bubble.  
 Remove all points (bubbles) for which you do not want to provide scenario 

information. 
 Add a point for years you would like to provide scenario information for. 
 Drag the bubble(s) of the year(s) you would like to change to the desired location. 
 Or right-click the bubble to enter the exact values for the year and the fertility lever.  
 Press the OK button to save your results and close the graph. 
 
You have now adapted the population scenario in the external factors section. After 
you have created a new sub-scenario for a driver you can save this sub-scenario. 
 Go to the File menu. 
 Click Save project. The Save project dialog window opens. 
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The system now allows you to choose between updating the non-predefined present 
integrated scenario and creating an integrated scenario under a new name. Note that 
you are not able to update sub-scenarios that are part of the predefined integrated 
scenarios. In this case the system will automatically inform you that you can only save 
the sub-scenario under a new name.  
 
To create a new integrated scenario, 
 Enter the new integrated scenario name in the text box next to Scenario name. 
 Enter the description for this integrated scenario in the text box next to Scenario 

description. 
 
To save the sub-scenario you have just created under a new name. 
 Select Save as new scenario on the dropdown list for the Population scenario row. 
 Click the Details… button. The Scenario details window opens.  
 Enter a new sub-scenario name and add a short description of the sub scenario. 
 Click the OK button. 
 Click the Save button at the bottom of the Save project dialog window. 
 

 
 
You have now created a new sub-scenario Test_population for the external factors - 
population scenario and a new integrated scenario Test. This sub-scenario can be 
used in the next step of the policy impact assessment: Creating integrated scenarios. 

3.2.1.3 How to load an existing population sub-scenario?  

To load an existing population sub-scenario, you should know how to work with the 
scenario manager. For more information, see the section Creating integrated 
scenarios. 
 Go to the Scenarios tab of the Main window. 
 Click the Scenario manager icon in the navigation pane. 
 Click on the New… button on the top-right of the content pane. The Create new 

integrated scenario dialog window opens.  
 Give your integrated scenario a new name and give a description of the integrated 

scenario (something you can remember the scenario by). 
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 Click on the dropdown list next to External factors - Population scenario. The 
existing external factors - population sub-scenarios display on the list. Select the 
one that you want to load. 

 Select the sub-scenarios for other drivers and press the OK button of the Create 
new integrated scenario dialog window. 

 Select the newly added integrated scenario on the dropdown list next to Integrated 
scenario on the toolbar. 

 Go to the Driver tab of the Main window. 
 Click the External factors icon. 
 Go to the Population part in the content pane.  
 
Now you have loaded the external factors - population sub-scenario that you had 
selected for the newly added integrated scenario. When you know the existing external 
factors - population sub-scenario that you are interested in is incorporated in a certain 
integrated scenario, you can load this integrated scenario. 
 Select the integrated scenario which incorporates your external factors - population 

sub-scenario of interesting on the dropdown list next to Integrated scenario on the 
toolbar. 

 Go to the Driver tab of the Main window. 
 Click the External factors icon. 
 Go to the Population part in the content pane.  
 
Now you have loaded the external factors - population sub-scenario that is 
incorporated in the active integrated scenario. 

3.2.1.4 How to make changes to an existing population scenario and save 
its results?  

To save the changes that you made to an existing population sub-scenario, you should 
already know how to work with the saving changes. For more information, see the 
section Saving changes.  
 Load an existing scenario as explained in the section „How to load an existing 

population sub-scenario?‟  
 Make your changes as explained in the section „How to adapt values for external 

factors?‟ 
 Choose the Save project command on the File menu. The Save project dialog 

window opens.  
 Give your integrated scenario a new name and give a description of the integrated 

scenario (something you can remember the scenario by). 
 Click the Save as new scenario option next to Population scenario.  
 Click the Details... button next to on the right side of the External factors - 

Population scenario row. The Scenario details dialog window opens. 
 Enter a new sub-scenario name in the text box next to Name. 
 Enter the description text in the text box next to Description. 
 Click OK at the bottom of the Scenario details dialog window. 
 Repeat the same steps for the other drivers if you have made changes.  
 Click the Save button at the bottom of the Save project dialog window. 
 
You have now created a new sub-scenario for population. This sub-scenario can be 
used in the next step of the policy impact assessment: Creating integrated scenarios. 

3.2.2 Policy measures 

 
 
Besides external factors, WISE also incorporates measures for economy, population, 
zoning regulations and infrastructure. These measures can be found by clicking on the 
Policy Measures icon under the Drivers tab in the navigation pane on the left hand side 
of the Main window. On the top part of the window you can enter and display the 
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economic information, the middle part the population and zoning information, and the 
bottom part is reserved for infrastructure network. First, you will learn how to adapt the 
economic and population measures. Second, you will learn how to work with the 
Zoning Tool. Finally, the options related to the Infrastructure will be explained. 
 

 
 
You can find the Economy part on the top right of the Policy measures window. Here 
you can adapt the values of Rate of change in land use productivity and Rate of 
change in labour force productivity for each sector. 

3.2.2.1 How to adapt values of economy measures? 

 Go to the Driver tab of the Main window and click the Policy measures icon in the 
navigation pane. 

 Select the Socio-economic measures from the dropdown list next to Driver. 
 Go to the Economy part in the content pane. 
 Select the economic sector of your interest from the dropdown list next to Rates of 

change in land productivity in sector.  
 Enter a new value in the text box on the right side for Rates of change in land 

productivity in sector.  
 
You have now changed the value of the rates of change coefficient for a certain sector.  

3.2.2.2 How to adapt values of population measures? 

 Go to the Driver tab of the Main window and click the Policy measures icon in the 
navigation pane. 

 Select the Socio-economic measures from the dropdown list next to Driver. 
 Go to the Population part in the content pane. 
 Select the district of your interest from the dropdown list next to District.  
 
The values of proportion of people living in each residential land use category for the 
selected districted are displayed in the table. The sum of proportion of people living for 
each land use category should be exactly 100. Otherwise, the values in that column 
are highlighted in red background.  
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The values for the start year of the simulation are given by default. If the columns are 
displayed as empty, that means the values for the start year will be used constantly 
over the simulation period. If the values are specified for more than one year, the 
system takes the interpolated values for the unspecified years on the basis of the 
values for its two closest specified years. 
 Specify the values for a specific year by entering new values for each residential 

land use category. The sum of proportion of people living for each land use 
category for this year should be exactly 100. 

 
You have now changed the policy measure for population for a certain district.  
 
Besides socio-economic policy measures, WISE also incorporates measures for zoning 
regulations and transport. You can select one of them on the dropdown list next to 
Driver in the content pane.  
 
First, you are going to learn how to incorporate the spatial planning with a tool named 
Zoning tool. Next, the options related to the Infrastructure will be explained. 

3.2.2.3 Zoning maps 

Zoning maps represent the policy part of the land use allocation process. Different 
locations have different restrictions for particular land uses. Areas that can be 
facilitating for one land use can be restrictive for other land use functions like protected 
nature, which facilitates natural land uses and at the same time restricts developments 
in residential or industry & commerce land uses. For this reason there is a specific 
zoning map for each main land use function incorporated in the system: residential 
(lifestyle blocks, low density and medium to high density), commercial, community 
services, horticulture, biofuel cropping, vegetable cropping, other cropping, dairy 
farming, sheep, beef or deer farming, other agriculture, forestry and manufacturing. 
The vacant land uses do not have a specific zoning map since we assume that this 
type of land use is allowed everywhere, but that there are no areas where it is 
specifically planned. In general, vacant land uses are the land uses that appear when 
(agricultural) land is abandoned and also the land use that can easily be taken over 
when population or economic functions expand.   

3.2.2.4 Zoning tool 

In WISE, the Zoning tool developed by RIKS is incorporated in the system that allows 
you to incorporate your spatial planning to the system by creating and edit zoning maps 
based on a number of spatial plans. With the Zoning tool, you can enter spatial zoning 
plans directly via the graphical user interface (GUI) and set the characteristics of each 
plan (parameters) and add new plans in the GUI as well in a comprehensible way. 
Plans can be ordered hierarchically, such that one overrules the other. When more 
information on zoning plans becomes available, this can be incorporated in the zoning 
maps, either by the project team, or by the users themselves.  
 
Before you start working on creating or editing the zoning maps with the zoning tool, 
you should understand the meaning of terms which are used in the Zoning tool. 
 
Plan – A plan is a map that represents any spatial plan. It contains source data which is 
not interpreted yet. The data in a plan should be categorical, not numerical. The map 
that represents the plan should have the same geo-reference as the region map 
(lower-left x coordinate, lower-left y coordinate, cell size, number of rows and columns). 
The data itself need not cover the entire modelling area, for example because it only 
covers one municipality. Uncovered areas must have a „no data‟ value. 
 
Category – A spatial plan can have one or several categories, each of which is 
represented by a category in the map. For example, a plan that outlines the protected 
areas can have the categories protected forests, protected natural area and non-
protected nature. No data values in the map will be interpreted as no data in the zoning 
tool – that is, they cannot be assigned a zoning status other than no data. 
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Zoning status – Each category in a plan needs to be interpreted in terms of their zoning 
status for each land use function separately. Moreover, a category can be interpreted 
as no data, meaning that the specific category does not influence a specific land use 
function or that no information for that location is available. 
 
Start time / End time – A category in a plan can start and stop at any given time in the 
simulation.  
 
Zoning map – The zoning map is the result of the interpretation and combination of all 
categories in all spatial plans. It indicates the zoning status in each cell for a particular 
time span. Zoning maps are specific for each land use function and have a timestamp, 
since zoning regulations can change over time. 
 
Numerical zoning map – The numerical zoning maps are used to calculate the total 
potential maps. They are derived from the (categorical) zoning maps for the current 
simulation time and the current land use map. Strictly, numerical zoning maps do not 
exist in the zoning tool itself, since the conversion to numerical values takes place 
when computing the total potential. For more information, see the section Zoning. 
 
The following paragraphs describe the features of working in the zoning tool. 

 Each category in a spatial plan is interpreted for all land use functions separately. In 
WISE, A category can be given one of the following interpretations/zoning status: 
Permitted, Controlled, Restricted discretionary, Discretionary, Non-complying, 
Prohibited and Unspecified. Refer to the Specification Report for more information 
about the zoning status used in WISE. 

 Some plans can overrule others; hence the order of the plans represents a 
hierarchy. This can mean that restrictions in one plan become allowed in the final 
zoning map, because they are overruled. This hierarchy can be set at the level of 
the categories (per plan). For example, an order could consist of Plan A, category 
1; Plan B category 1, Plan A category 3, Plan C category 1, etc. This hierarchy 
among categories is assumed to be the same for all land use functions. 

 A category in a plan can start or stop at any given point during the simulation. By 
default a plan is valid from the start year of the simulation until the end year of the 
simulation. However the start year, the end year or both can be set per category. 
This time setting per category is assumed to be equal for all land use functions. 

 The result of the combination of the categories of all plans is a categorical map (the 
zoning map) that shows the zoning status for each cell. However, since plans can 
start and stop at any given time in the simulation, there is a separate zoning map 
for each point in time when a new plan starts or ends. 

 Since some plans only start after the initial year of the simulation, each year the 
zoning status is corrected for the De Facto land use. Hence, if a location has a 
certain land use, it will not be removed because of newly introduced zoning plans. 
To disable this option, uncheck all the check box in the De Facto zoning table 
through the modeller user interface. For more information, see the section Zoning. 

3.2.2.5 General steps to create zoning maps in the zoning tool 

You can take the following steps in general to introduce a new spatial plan and create 
the zoning maps. 
 Go to the Zoning tool via Main window → Drivers → Policy measures → Driver 

Zoning. 
 Import the maps representing the spatial plans into the system.  
 Set the hierarchy among categories by clicking on the category and clicking the 

scroll buttons on the left side of the table to move them upwards or downwards 
through the hierarchy. This hierarchy is assumed to be the same for all land use 
functions, and therefore it only needs to be set once. 

 Set for each category the start year and the end year when this is different from the 
default value. This start year and end year per category is assumed to be similar for 
all land use functions and therefore needs to be set only once. 
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 For each land use function interpret all categories. This can be done by selecting 
the proper interpretation from the available options. 

 Set the matrix of De Facto land uses that is used to compute the numerical zoning 
maps through the modeller user interface. For more information, see the section 
Zoning. 

 
In the following steps you will learn in detail how to set up the zoning regulations for a 
new project and import a new plan to the existing overlay via the GUI of the zoning tool. 

3.2.2.6 How to set up spatial planning for a project file with an empty 
zoning tool? 

For example, a WISE project file has been set up without information on spatial 
planning. You would like to introduce a district reserves and covenants map and a 
protected areas map and you know how to interpret the values in these maps. 
 Make sure that you have opened the new project file to which you want to introduce 

these maps. 
 
To access the zoning tool: 
 Go to the Drivers tab of the Main window and click the Policy measures icon. 
 Select Zoning in the dropdown list next to Driver in the content pane on the right 

side of the Main window. It is empty in the content pane except for some buttons at 
the bottom. 

 
To import a new plan: 
 Make sure that the plans you want to introduce are pre-processed to the correct 

raster format for inclusion in WISE. They should have the same size, resolution, 
projection, lower-left coordinate as the regions map used in the system and with the 
file extension .asc, .img or .rst.  

 Click the Import plan… button at the bottom of the content pane. The Import plan 
dialog window opens. 

 Enter a name for the spatial plan District Reserves and Covenants that you are 
going to import in the text box next to Name. Click the browse button next to Map 
file. The Select zoning plan map window opens. 

 Navigate to the spatial plan file that you want to import and double-click on it. 

 
 
To use an existing legend for the newly imported plan: 
If the legend for the spatial plan that you just imported already exists in the system, you 
can use this existing legend:  
 Click on the radio button in front of Use existing legend. 
 Select the legend from the dropdown list next to Use existing legend. 
 Press the OK button in the Import plan dialog window. 
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To create a new legend for the newly imported plan: 
If there is no legend file for the spatial plan that you just imported, you can create a 
new legend for it. 
 Click on the radio button in front of Make new legend. 
 Enter the legend file name for in the text box next to Make new legend. 
 Click the Edit legend… button. The Legend editor dialog window opens. 
 Edit the legend for the spatial plan that you just imported in the Legend editor dialog 

window. For more information, see section Legend editor. 
 
It is important to define the categories with correct number of classes and proper labels 
in the Legend editor dialog window when you import a new plan.  
 
 Press the OK button in the Legend editor dialog window and close the Legend 

editor dialog window. 
 Press the OK button in the Import plan dialog window. 
Now you have imported the spatial plan and selected or created a legend file for it. 
 
To modify the legend for a newly imported plan: 
 Select the spatial plan on the Plans and categories tab. 
 Click on the Edit… button. The Edit zoning plan dialog window opens. 
 Click the Edit legend… button. 
 In the Legend editor dialog window, you can enter new labels and set new colours. 

For more information, see section Legend editor 
 Press the OK button in the Legend editor dialog window and close the Legend 

editor dialog window. 
 Press the OK button in the Edit zoning plan dialog window. 
 
The categories of this plan will be updated automatically. If you want to modify the 
legend of a spatial plan, it is important for you to access the Legend editor dialog 
window via the Edit… button instead of the Show button on the Plans and categories 
tab.  
 
It should be noted that except for editing colours, changing other parts of the legend 
will cause the reset of the zoning tool. In other words, the setting you made on the 
Category precedence tab will be initialized. Therefore, it is recommended to first edit 
the legend (including defining the labels) for the imported plan before setting the 
parameters on the Category precedence tab.  
 
To show a plan and its categories 
 Go to the Plans and categories tab. 
 Double-click the plan Protected areas that you just imported.  
 
The content pane under the Plans and categories tab now fills with a hierarchy three 
that shows an item District Reserves and Covenants with the two sub-items categories: 
District Reserves, and District Covenants.  
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You can expand or collapse the braches of plan and categories tree by moving the 
mouse over the name of plan and double-click or moving the mouse over the box in 
front of the name and left-click.  
 
To check that you selected the right map,  
 Select the District Reserves and Covenants item under the Plans and categories 

tab. 
 Click the Show… button under the plans and categories tree. A map window opens 

showing you the District Reserves and Covenants map window.  
 Close the District Reserves and Covenants map window. 
 

 
 
You can import a second plan similarly: 
 Click the Import plan… button. The Import plan dialog window opens. 
 Enter a name for the Protected Areas map click the browse button next to Map file 

to select the map file for Protected Areas. 
 Create a new legend for the Protected Areas map. 
 Click the OK button in the Import plan dialog window.  
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The Protected Areas hierarchy tree is added in the content pane which shows the item 
Protected Areas with its six categories. 
 

 
 
By default, the zoning status of each category is set to unspecified. According to your 
interpretation of each category, you can set the Zoning tool by the following steps: 
 Go to the Categories precedence tab. 
 Set the hierarchy among categories by selecting the category and clicking the scroll 

buttons to move them upwards to downwards through the hierarchy. A category 
that is higher on the list will overrule categories that are lower on the list in case 
they are in conflict. 

 
We assume that the hierarchy is a function of the plan itself, and not for the specific 
land use type in WISE. Therefore you don‟t need to set up the hierarchy for each land 
use type as it is the same for all land use functions. 
 

 
 Select Residential – Lifestyle Blocks from the dropdown list next to Land use type. 
 Set the zoning status for each category on the list by selecting the one from the 

drop down list in the Zoning status column. 
 
Finally, you need to set the start and end time of each category. By default these are 
set to begin and end of the simulation, which is fine for the most categories. For 

Scroll button 

Start time of simulation 

End time of simulation 
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example, the restriction to develop Residential – Lifestyle Blocks according to the 
District Reserves only starts from 2010.  
 Click the browse button in the Start time column and the District Reserves raw. The 

Start date for category dialog window opens.  
 

 
 
 Click the radio button in front of the Specific date and click the 1-1-2010 from the 

dropdown list. Then press the OK button. 
 
The specific start time appears in the corresponding cell of the table. For the categories 
for which you have not specified the start time or the end time, the symbol is 
displayed in the start time column and the symbol is displayed in the end time 
column to indicate the start of simulation and the end of simulation, respectively.  
 
The zoning regulations for the land use function Residential – Life style blocks is set as 
depicted in the figure above. Now you can preview the zoning map for this land use. 
 Make sure you have selected Residential – Life style blocks on the drop down list 

next to Land use type. 
 Click the Preview zoning map button at the bottom of the content pane of the 

Spatial planning window. The Preview zoning map Residential – Lifestyle Blocks 
window opens. 
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In the map window, multiple layers of the zoning map for Residential – Lifestyle Blocks 
at different time points are available in the layer manager pane. The map displayed in 
the Map pane represents the zoning map for the selected time point. The reason for 
displaying these layers is that these time points are used to set as either the start time 
or the end time for different categories for the selected land use. For more information 
about working with a map window, see the section Map window. 

3.2.2.7 How to change a plan in the list? 

 Make sure that you have opened the Zoning tool. 
 Go to the Plans and categories tab in the content pane. 
 Select the plan that you want to edit on the plan and categories tree by clicking on 

it. 
 Click the Edit… button under the plan and categories tree. The Edit zoning plan 

dialog window opens where you can change the name of the plan in the text box 
next to Name, you can load a new plan and load a new legend file or edit the 
legend of the plan. 

 Click the OK button in the Edit zoning plan window to save changes that you made. 
 

 

3.2.2.8 How to remove a plan from the list? 

 Make sure that you have opened the Zoning tool in front of you. 
 Go to the Plans and categories tab in the content pane. 
 Select the plan that you want to remove on the plan and categories tree by clicking 

on it. 
 Click the Remove button under the plan and categories tree.  
 
You have removed the selected plan from the list. The corresponding categories of this 
plan will be removed as well in the Categories precedence tab. 

3.2.2.9 How to introduce a new plan to the set of zoning regulations? 

Based on the zoning regulations that you just set up in the previous section (How to set 
up spatial planning for a project file with an empty zoning tool?), you can now introduce 
a new plan. This new plan should be pre-processed in a GIS package with the correct 
raster format to be used by WISE.  
 Make sure that you have opened the Zoning tool in front of you. 
 Click the Import plan… button. The Import plan dialog window opens. 
 Enter the name of the new plan, and load the map and its legend on your computer. 

Click the OK button in the Import plan dialog window.  
 
The new plan hierarchy tree is added in the content pane with the sub-items as 
categories. 
 Click the Categories precedence tab. The categories in the new plan show up 

lowest in the hierarchy. By default new plans are valid for the whole simulation 
period and the zoning status is set to „unspecified‟. 

 
Now you need to adjust settings for the categories in the new plan on the basis of the 
existing hierarchy that already includes protected areas and district reserves and 
covenants. According to your interpretation of each category, you can interpret the new 
zoning regulation as follows: 
 Go to the Categories precedence tab. 
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 Set the hierarchy among categories in the new plan by selecting the category and 
clicking the scroll buttons to move them upwards to downwards through the 
hierarchy. From the top to the bottom, the one on the top overrules the one on the 
above.  

 Drag the category No data to the bottom of the hierarchy. 
 Set the hierarchy among categories in the new plan by selecting the category and 

clicking the scroll buttons to move them upwards to downwards through the 
hierarchy.  

 
You have adjusted the hierarchy for all the categories in the three plans now. You don‟t 
need to adjust the hierarchy for each land use type because this is the same for all land 
use functions. 
 Select Residential – Lifestyle Blocks from the drop down list next to Land use type. 
 Set the zoning status for each category in the new plan by selecting one from the 

drop down list in the Zoning status column. 
 
You need to set the zoning status for each category, and specify the start and end time 
of each category. The final zoning regulations for the land use function Residential – 
Lifestyle Blocks is set on the basis of three plans. Now you can view the zoning map 
for industry that you just set up. 
 Make sure you have selected Residential – Lifestyle Blocks on the dropdown list 

next to Land use type. 
 Click the Preview zoning map button at the bottom of the content pane of the 

Zoning window. The Preview zoning map Residential – Lifestyle Blocks window 
opens. 

 
The set of zoning maps is recomputed when the simulation is opened and every time a 
change is made in the settings of the Zoning tool. The zoning map displayed in the 
Preview zoning map window will be updated automatically if a change is made in the 
setting of the Zoning tool. 

3.2.2.10 Infrastructure networks 

The relationship between land use and transport systems is generally recognized, by 
planning professionals as well as scientists. Also, and importantly, it is recognized that 
the relationship is reciprocal, which means that developments in land use are in part a 
consequence of the transport system and, at the same time, developments in the 
transport system are by large the effect of land use changes.  
 
The current version of WISE only incorporates a one-way interaction from transport on 
land use. In future versions a transport model can be incorporated with which the 
impact of land use on transport can also be calculated. In WISE infrastructure is 
represented as network layers. There are three network layers incorporated in WISE: 
Transport network (road and railway), Major processing sites and Residential 
attractants. 
 
Accessibility is a function of the distance of a location to this network and its 
importance, which can be set from the modeller user interface. Policy decisions related 
to the changing accessibility are mainly the construction of roads, railways and 
(possibly) irrigation networks. In this exercise you will learn how to adapt the road 
network. 
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The figure above shows the policy user interface for the Infrastructure driver. The 
changes to the network are listed in the table with time and descriptive names. It is 
allowed to have several changes in the same year. You can use the button Show / Edit 
network at time… to open a window with a single network map displaying the network 
at the chosen time (incorporating all specified network changes). You can add or 
remove elements from this network or change the accessibility type of an element 
(residential road, etc.) by using the Import network change… button or the Remove 
selected changes… button. You can store the changes you made as a new network 
change and give a descriptive name. You can view and edit each network change in 
isolation in the modeller user interface via Main window → Drivers → Parameters → 
Land use → Accessibility → Go to infrastructure layers button → Infrastructure layers 
window (for more information see the section Accessibility ). 

3.2.2.11 How to view an infrastructure network? 

 Go to Drivers tab of the Main window. 
 Click Policy measures icon in the navigation pane on the left side of the Main 

window. 
 Select Infrastructure from the dropdown list next to Driver. 
 
You will see the information related to infrastructure displayed on the content pane.  
To view a network at a specific time: 
 Select the infrastructure network of interest from the dropdown list next to Network. 
 Click the Show network at time… button at the bottom of the window. The Select 

time for network dialog window opens. 
 Select your date of interest on the dropdown list of the Select time for network 

window. 
 Click the OK button in the Select time for network window. The Network layer ### 

*** map window opens, where ### represents the name of the selected 
infrastructure network and *** represents the selected date. 

3.2.2.12 Network map window opened via the policy user interface 

The user interface of the network map window opened via the policy user interface is 
different from the one opened via the modeller user interface. In this section, we focus 
the one opened via the policy user interface. For the latter one, please refer to the 
section Network map window opened via the modeller user interface.  
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This window with a single network map displays the network at the chosen time 
(incorporating all specified network changes). The figure above is an example of the 
transport network for 2010. The title of the network map window indicates the 
descriptive name of the selected network and the selected year. As depicted in the 
figure above, besides the District boundaries layer, there is only one layer Transport 
network 2010-Jan-01 visible in the layer manager pane, which shows the high-level 
overview of the network changes for the selected time in the map pane.  
 
The legend pane consists of 4 legend tabs which are used for editing the legend of 
network map. The Link color tab and Link width tab are the most useful tabs. For more 
information about how to edit legend, see the section Legend editor. 

 In WISE, for all infrastructure layers, the categories of Acctype are used as the 
legend. For more information, see the section Network legends.  

 
The ratio buttons in the legend pane indicate that this network map is editable. You can 
view and edit the link properties or add new links on the network map.  
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For all the Infrastructure layers in WISE, you can view or edit the accessibility type. 
 Select the network layer of interest from the dropdown list next to the Network, for 

example, the Transport network. 
 Double-click on the link of interest on the selected network layer. The Edit 

accessibility type dialog window opens. This is the link property used in the land 
use model. You can edit the accessibility type for the selected link from here. 

 Click Cancel to close the Edit accessibility type dialog window. 
 Or click OK to confirm the change that you made. A message window appears to 

ask you whether or not to save the changes you have made.  
 

 
 
 Specify the name and path of the file that you want to save changes to. 
 Press OK. 

3.2.2.13 How to import a network at a specific time? 

You are going to import a network change for the year 2010 that only indicates the 
information of the new roads which will be built in the year 2010. The network change 
map is prepared in a GIS package with the correct format required in WISE.  
 Go to Drivers tab of the Main window. 
 Click Policy measures icon in the navigation pane on the left side of the Main 

window. 
 Select Infrastructure from the dropdown list next to Driver. 
 Select Transport network on the dropdown list next to Network. 
 Click the Import network change… button on the right side of the content pane. The 

Import network change dialog window opens. 
 Enter a name that could describe this network change in the text box next to Name. 
 Click the browse button next to File. The Open network change layer dialog window 

opens. 
 Select the network change map for the year 2010 and double click it. This map file 

should have the extension *.shp. 
 Select 2010-Jan-01 on the dropdown list next to Time. 
 Click the checkbox next to Incremental.  
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 Press the Ok button in the Import network change dialog window to save changes 
that you made. 

 

 
 

 If the network change map that you are importing only indicates some new changes 
for the chosen time, you should select the option of Incremental by clicking the 
checkbox next to Incremental. 

 If the network change map that you are importing indicates the whole network map 
including new changes and non-changed parts for the chosen time, you should not 
select the option of Incremental. 

 
Now you see the network change for the year 2010 is added on the list. 
 

 
 
To verify the network change map that you just imported 
 Click the Show / Edit network at time… button on the bottom-right of the content 

pane. The Select time for network dialog window opens. 
 Select the date 2010-Jan-01 on the dropdown list next to Time. 
 Click the OK button in the Select time for network dialog window. The Network layer 

### ***  map window for the selected time opens, where ### represents the 
selected network layer and *** represents the chose time. 

 Unselect the check box next to Show nodes in the Network tools to display all links 
on the map. 
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For more information about how to work with the map window, see the section Map 
window. 

3.2.2.14 How to adapt a network at a specific time? 

There are two ways to introduce a new road; you can either do it by drawing a line in 
the user interface of WISE, or by introducing it as a shape file that you prepared in a 
GIS package. Since the manually drawn segments are often inaccurate and not 
connected to the rest of the road network, it is advisable to introduce the new road in a 
GIS first. For the sake of the exercise however, we explain how to draw and remove a 
road in WISE. 
 
To add a new road 
 Go to Drivers tab of the Main window. 
 Click Policy measures icon in the navigation pane on the left side of the Main 

window. 
 Select Infrastructure from the dropdown list next to Driver. 
 Select Transport network on the dropdown list next to Network. 
 Click the Show / Edit network at time… button at the bottom of the window. The 

Select time for network dialog window opens. 
 Select 2010-Jan-1 on the dropdown list of the Select time for network window. 
 Click the OK button in the Select time for network window. The Network layer 

Transport network map window for the selected year opens. 
 Zoom in your area of interest with the zoom tools. See the section Zoom tools. 
 Select the radio button in front of the network category of interest in the legend 

pane. 
 Click the Select/edit button under Network tools.  
 Click the Add link button under Network tools. 
 Move the mouse pointer to the location where you want to add the new road and 

drag it to draw the road. The new road is displayed in the colour defined in the 
legend pane. 

 Click the Select/edit button again to disable the Add link button. 
 Double click on the road you just draw or right-click on it and select the option 

Properties. The Edit accessibility type dialog window opens.  
 Verify or select the accessibility type from the dropdown list.  
 

 
 
To save the changes 
 Close the map window. A message window pops up to ask you whether or not save 

the changes you made. 
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 Click the Yes button in the message window. The Save network change dialog 
window opens. 

 Enter a name to describe the changes that you made in the text box next to Name. 
 Click on the browse button next to File. The Save network change layer dialog 

window opens. 
 Navigate to the folder that you want to save the file and give a new name for this 

file with extension .shp.  
 Click the Save button in the Save network change layer dialog window. 
 Click OK in the Save network change dialog window. 
 
The newly added change for 2010 is displayed in the Network change list.  
 

 
 
To delete the new link that you just drew 
 Click the Show / Edit network at time… button at the bottom of the window.  
 Select 2010-Jan-1 on the dropdown list of the Select time for network window. 
 Click the OK button in the Select time for network window. The Network layer 

Transport network map window for the selected year opens. 
 Zoom in your area of interest with the zoom tools. See the section Zoom tools. 
 Click the Select/edit button. 
 Right-click on the newly drawn link and click the Delete on the context menu.  
 Repeat the steps above to delete the two nodes of this link as well. 
 Close the map window. 
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A message window opens where you are asked whether you want to save changes 
you made or not.  
 Click the Yes button in the message window. The Save network change dialog 

window opens. 
 Enter a name to describe the changes that you made in the text box next to Name. 
 Click on the browse button next to File. The Save network change layer dialog 

window opens. 
 Navigate to the folder that you want to save the file and give a new name for this 

file with extension .shp.  
 Click the Save button in the Save network change layer dialog window. 
 Click OK in the Save network change dialog window. 
 

 
 
The newly added change for 2010 is displayed in the Network change list.  
 

 
 
The text above describes how to save changes that you made on the network map.  
Be aware that if you use the present name, the existing file will be overwritten with the 
same name. For more information about how to work with an editable map, see the 
section Editable map. For more information about how to work with the network map, 
see the section Network tools 
 
You can also draw a new link or remove a link in the modeller user interface via Main 
window → Drivers → Parameters → Land use → Accessibility → Go to infrastructure 
layers button → Infrastructure layers window (for more information see the section 
Accessibility). It is strongly recommend to add a new link or to remove a link via the 
policy user interface as described above because the policy user interface doesn‟t 
display all the technical details. 

3.2.3 Filtering the economic sectors 

In WISE, there are 48 sectors of WRDEEM included in the economic model. These 
sectors are filtered for display in the external factors, policy measures and economic 
indicators. A default selection is implemented in WISE. You could adjust the selection 
which sectors are available for each respective driver or indicator in the economic 
model window (see the section Sector filter). The filtered lists of sectors are ordered 
alphabetically for easier look-up. 
 
In this section you have become familiar with the different drivers in the system. In the 
next section you will learn how to combine these sub-scenarios to create integrated 
master scenarios. 
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3.3 Creating integrated scenarios 

In the previous sections you have read how to adapt the different drivers that are 
incorporated in the system. Furthermore, you have learned that each of these drivers 
can be stored in different sub-scenarios (see the section Saving sub-scenarios). 
Through this section, the project file Waikato.geoproj will be used as an example. 
 

 
 

3.3.1 Predefined scenarios 

WISE contains one integrated scenario, the Baseline scenario, which is predefined and 
is not editable by the user. All sub-scenarios that constitute this integrated scenario are 
read-only as well.  
 
Particularly, WISE provides 8 predefined sub-scenarios for External factors – Climate 
driver and you can use them to create new integrated scenarios. The sub-scenario 
Medium emission trend with variability is read-only since it is used in the Baseline 
integrated scenario; other sub-scenarios for the climate driver are editable. For more 
information of these climate scenarios, we refer to the specification report of WISE. 

3.3.2 cenario manager 

The Main window in WISE is structured according to the four steps involved in an 
impact assessment analysis: 
1. Set up relevant drivers. 
2. Combine and run scenarios. 
3. View indicators visually. 
4. Analyse scenario results visually and analytically. 
Each step corresponds with a tab in the main window. The scenario manager is 
involved in the first two steps. 
 

 
 
You can access the Scenario manager by clicking on the Scenarios tab of the Main 
window. The Scenario manager icon is selected automatically in the navigation pane 
on the left side of the Main window. The content pane on the right side of the Main 
window shows the content of the scenario manager. 
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The Scenario manager allows you to change the description of non-read-only 
integrated scenarios, create new integrated scenarios and delete non-read-only 
integrated or non-read-only sub-scenarios.  
 
The Integrated scenario pane is in the top part and the Sub-scenario pane is in the 
lower part of the content pane of the Main window. Note that the term sub-scenario is 
not used in the user interface. For more information, see the section Project file, 
integrated scenario and sub-scenario.  

 On the top of the Integrated scenario pane, you can select an integrated scenario 
from a dropdown list. The active integrated scenario is indicated in the list marked 
with the word active.  

 

 When you select an integrated scenario from the list, the description of the selected 
integrated scenario is shown in the Integrated scenario pane and the selected 
integrated scenario details in the Sub-scenarios pane will be updated. If you hover 
the mouse pointer over one of the sub-scenario names, its description is displayed 
in a tooltip box – the pop-up box with a yellow background. 

 

 You can edit the description of the integrated scenario directly, unless the 
integrated scenario is read-only. 

 

 When the active integrated scenario or a read-only integrated scenario is selected, 
the Select… button is disabled. When the non-active and non read-only integrated 
scenario is selected, you can change a sub-scenario which is part of that integrated 
scenario by clicking the Select… button for the corresponding driver (e.g. Economic 
scenario, Population scenario, etc). A dialog window opens as depicted below, 
where you can select one of the available sub-scenarios. 

 

 
 

Sub-scenarios pane 

Integrated scenario pane 
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You can view all the sub-scenarios and you can edit the sub-scenarios which are not 
read-only by clicking the Edit… button. A dialog window opens as depicted below, 
where you can edit the name and description of that sub-scenario. Sub-scenarios can 
only be deleted if they are not selected in any of the available integrated scenarios. 
 

 

3.3.2.1 How to view an existing integrated scenario? 

 Go to the Scenario tab of the Main window. 
 Click your integrated scenario of interest on the dropdown list next to Integrated 

scenario on the top of the right side of the window. 
 View the description of the selected integrated scenario in the Integrated scenario 

pane. 
 View the sub-scenario for each driver that is incorporated in the selected integrated 

scenario in the Sub-scenarios pane. 
 Move the mouse over the name of your sub-scenario of interest. Its description 

displays in a tooltip box with yellow background. 
 
Selecting and viewing an integrated scenario does not automatically mean that its data 
is loaded into the system. Only the active integrated scenario is loaded into the system.  

3.3.2.2 How to load an existing integrated scenario? 

 Click the dropdown list next to Integrated Scenario on the toolbar at the top of the 
Geonamica application window (note this is not the list next to Integrated Scenario 
at the top of the Integrated scenario pane of the Scenario manager window). All the 
available integrated scenarios will be displayed on the list. 

 Select an integrated scenario from the list as the active integrated scenario. 
 
Now this integrated scenario is loaded by the system. However, if changes are made to 
the input data/files and parameters in the current active integrated scenario, a message 
window appears to ask you whether or not to save the changes when you switch to 
another integrated scenario. 
 

 
 
 Click the Cancel button if you wish to cancel the action of loading another 

integrated scenario. 
 Click the No button if you wish to discard changes you made in the active 

integrated scenario. Then the system loads the new integrated scenario as the 
active integrated scenario. 

 Click the Yes button if you wish to save changes you made in the active integrated 
scenario. The current integrated scenario is displayed on the dropdown list on the 
toolbar and the Save project dialog window opens where you can determine how to 
save changes. For more information, see the section Saving changes. After you 
save the changes in a new integrated scenario via the Save project dialog window, 
the newly created integrated scenario becomes the active integrated scenario 
automatically on the dropdown list on the toolbar. 
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Note that loading the active integrated scenario means loading the input data/files and 
parameters defined in this integrated scenario to the graphic user interface. In this 
case, the models have not been updated to the changes. You can use the Update, 
Step, Run and Reset command to update the models of the system to the changes. 

3.3.2.3 How to create a new integrated scenario? 

An integrated scenario is a collection of existing sub-scenarios for each driver. There 
are two ways to create a new integrated scenario in WISE. We first introduce how to 
create a new integrated scenario in Scenario manager. 
 Go to the Scenario tab of the Main window. 
 Click the New… button on the integrated scenario pane on the right side of the 

Main window. The Create new integrated scenario dialog window opens. 
 Name the new integrated scenario in the text box next to Integrated scenario name 

and give a short description in the text box. 
 In the sub-scenario pane, select an existing sub-scenario from the dropdown list for 

each driver.  
 

 
 
The existing sub-scenarios on the list has been created when you saved changes by 
using Save project or Save project as… command on the File menu. 
 Click the OK button in the Create new scenario window. 
 
The new integrated scenario Test that you just created is displayed immediately on the 
dropdown list on the top of the integrated scenario pane. 

 
 
We now introduce how to create a new integrated scenario by using the Save project 
command. You can create a new integrated scenario based on an existing integrated 
scenario. 
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 Load your integrated scenario of interest by selecting it from the dropdown list next 
to Integrated Scenario on the toolbar. See „How to load an existing integrated 
scenario?‟. 

 Adapt your external factors or policy measures of interest. See the section Setting 
up the drivers. 

 Click the Save project command on the File menu. The Save project dialog window 
opens.  

 Give a new name for the integrated scenario that you adapted and define the sub-
scenarios for each driver if necessary. For more information, see the section Saving 
an integrated scenario. 

 Press the Save button on the Save project dialog window. 
 
You have now created a new integrated scenario and it displays as the active 
integrated scenario on the toolbar. 

 If you would like to learn how to create sub-scenarios for different drivers or if you 
would like to learn how to see the data that is used in the different drivers, go to the 
section Setting up the drivers. 

 

 If you want to carry out a simulation with your new integrated scenario, press the 
Reset button on the toolbar or click the Reset command on the Simulation menu. 

3.3.2.4 How to delete an integrated scenario? 

You can only delete any integrated scenario which is not read-only and which is not the 
active one.  
 Go to the Scenario tab of the Main window. 
 Click the integrated scenario that you want to delete on the dropdown list next to 

Integrated scenario on the top of the right side of the window. The Delete button 
becomes enabled if the selected integrated scenario is not read-only and is not the 
active one.  

 Click the Delete button on the top-right of the window. 
 
The integrated scenario that you deleted disappears from both the dropdown list on the 
toolbar and the dropdown list on the top of the main window. You have now deleted the 
integrated scenario. 

3.3.2.5 How to delete a sub-scenario for a specific driver? 

You can only delete a sub-scenario which is not read-only and which is not part of any 
existing integrated scenario.  
 

 
 
 Go to the Scenario tab of the Main window. 
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 Click the Edit… button next to the specific driver, e.g. External factors - Population 
scenario. The Edit external factors - population scenarios dialog window opens. 

 Click the dropdown list next to Scenario name of the Edit population scenarios 
dialog window. All the available sub-scenarios for this driver are displayed on the 
list. 

 Click the sub-scenario you want to delete. The Delete button becomes enabled if 
the selected sub-scenario is not read-only and is not part of any existing integrated 
scenario.  

 Click the Delete button on the top-right of the Edit external factors - population 
scenarios dialog window. The sub-scenario that you deleted immediately 
disappears from the dropdown list of the Edit external factors - population scenarios 
dialog window. But it has not been completely deleted until you press the OK 
button. 

 Click the OK button on the Edit external factors - population scenarios dialog 
window. 

 
To verify that it is completely deleted, 
 Click the Edit… button next to that specific driver, e.g. External factors - Population 

scenario. The Edit external factors - population scenarios dialog window opens. 
 Click the dropdown list next to Scenario name on the Edit external factors - 

population scenarios dialog window. The deleted sub-scenario is not displayed on 
this list any more. 

3.3.3 Examples of using the scenario manager 

The section above describes the detailed information in the scenario manager. This 
section provides outlines for best use of the scenario manager in WISE. Several case 
studies will be explained in a step-by step manner.  

3.3.3.1 Creating your own sub-scenarios 

When you first open WISE, it only contains the baseline, or business as usual, sub-
scenarios and the predefined sub-scenarios for climate. There is exactly one integrated 
scenario called Baseline, which combines the baseline sub-scenario for each driver. 
You can develop your own sub-scenarios on the basis of these baselines. 

Defining a High export sub-scenario 
 Go to the Drivers tab in the Main window and click on External factors. 
 Select the Paper and paper product manufacturing sector from the list for the 

International exports. 
 Click the graph button to open the graph window showing the time line of 

international exports for the selected sector – see 0. 
 Click the Options button to set the maximum value on the Y-axis to 150. 
 Right click on the bubbles in the graph to set the values as shown in 0. These 

values assume a 1% annual growth from 2011. 
 When you are done, click the OK button. 
 
You have now changed the time line for international exports for one of the relevant 
sectors. If you would like, you can repeat the steps above for other sectors as well. 
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Graph window for international exports opened from the External factors in the Main 

window 

Saving the High export sub-scenario 
You have now entered a scenario for increased international exports in the system and 
are ready to save this to disk. 
 Click the Save button on the toolbar in order to save your changes as a new sub-

scenario. 
 Select Save as new scenario for the External factors – Economy scenario. 
 Click on the Details button to enter a name and description for the sub-scenario – 

see 0. 
 Click the OK button when you have filled in the name and description. 

 
Scenario details window opened from the Save project window 

 
When you save a project in WISE you cannot save only part of the changes you have 
made, in the same way that you cannot save half a Word document or send half an e-
mail. Therefore, you have to either save or discard the changes you have made for 
each of the drivers. You can overwrite the currently selected sub-scenario or save in a 
new sub-scenario – thereby retaining the currently selected sub-scenario. 
 
You also have to specify an integrated scenario that will consist of the sub-scenarios 
you are about to save. Here again, you can either overwrite an existing integrated 
scenario or save to a new integrated scenario. Since we want to retain the Baseline 
integrated scenario for later, we have to specify another name. It doesn‟t really matter 
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which name you use right now, since you are just interested in saving the sub-
scenarios. In the next section, you will combine the sub-scenarios you create now into 
integrated scenarios. 
 Enter the name Temp for the integrated scenario in the Save project window. 
 Click the Save button in order to save the project. 
 

 
Save project window after all information has been entered 

 
You have now created a new sub-scenario for External factors – Economy that 
assumes an increase in international exports. In the same way you can create another 
sub-scenario that assumes a decline in international exports, or you can define sub-
scenarios for the other drivers available in WISE. 
 
In the next section we will learn how to combine the sub-scenarios we created as part 
of integrated scenarios for which we can perform a simulation run and investigate the 
impacts of our assumed driver developments. 

3.3.3.2 Managing integrated scenarios 

If you have followed the steps in the previous section, you now have two integrated 
scenarios: Baseline, using the baseline sub-scenario for External factors – Economy 
and Temp, using the High export sub-scenario. You can verify this in the Scenario 
manager that is opened by clicking the Scenarios tab in the Main window – see 0. 
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The Scenario manager in the Main window 

Creating a new integrated scenario 
If you want to investigate the impact of climate change, you can run a simulation using 
e.g. the high emission climate scenario and compare the results with the baseline 
integrated scenario that uses the medium emission climate scenario. In order to do 
this, we first have to create a new integrated scenario that uses the high emission sub-
scenario for climate. 
 Go to the Scenarios tab in the Main window. 
 Click the New button to create a new integrated scenario. 
 Select the High emission trend with variability sub-scenario for climate. 
 Select the Baseline sub-scenario for the other drivers. 
 Enter the name Climate change for the integrated scenario. 
 Click the OK button. 
 

 
Create new integrated scenario window opened from the Scenario manager in the Main 

window 

 
To run a simulation with the newly created integrated scenario, you must first activate 
it. 
 Select the integrated scenario Climate change from the list in the toolbar – see 0. 
 Click the Run button on the toolbar to run the simulation. 

Sub-scenarios for each driver 

Integrated scenarios 
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 If you don‟t want to wait for the simulation to finish, click the Stop button on the 
toolbar. 

 

 
Selecting the newly created integrated scenario 

Removing an integrated scenario 
Remember that when you created and saved a sub-scenario in the previous section, 
you also saved a new integrated scenario. Since you don‟t need that one anymore, you 
can remove it. 
 Make sure that in the toolbar, the active integrated scenario is set to Baseline. 
 Go to the Scenarios tab in the Main window. 
 Select the integrated scenario Temp. 
 Click the Delete button. 
 Click the Save button in the toolbar to save your project. 
 
Note that it is not possible to remove an integrated scenario when it is selected as the 
active scenario. In that case, you first have to activate another integrated scenario in 
the toolbar. 

Changing an integrated scenario 
You can change an integrated scenario by selecting another sub-scenario for one of 
the drivers. E.g. in the integrated scenario Climate change we have selected the 
baseline sub-scenario for External factors – Economy, but we could change this to the 
High export sub-scenario that we have created earlier. 
 Make sure that in the toolbar, the active integrated scenario is set to Baseline. 
 Go to the Scenarios tab in the Main window. 
 Select the integrated scenario Climate change. 
 Click the Select button next to the External factors – Economy scenario. 
 Select the sub-scenario High export. 
 Click the OK button. 
 Click the Save button in the toolbar to save your project. 
 

 
Select external factors – economy scenario window opened from the Scenario manager 

in the Main window 

 
Note that it is not possible to change an integrated scenario when it is selected as the 
active scenario. In that case, you first have to activate another integrated scenario in 
the toolbar. 
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3.4 Running the simulation 

A more general description about running the simulation is available in the section 
Running the simulation. In this section you will learn how to load an integrated scenario 
and run the simulation and save its output results while running the simulation. 

3.4.1 Saving output results 

There are several ways in WISE that you can save output results. Before you run the 
simulation, you need to set up in which way and what you want to output. 

3.4.1.1 Exporting individual maps 

To export a map you need to have the map open in your active Map window. In this 
window you find the Save grid button in the Tools pane on the right low part of the 
window (see for example the Land use map window). 
 
Clicking on the Save grid button allows you to export the map to any folder you like. 
There are several different file types that you can choose to export maps, from these 
the Arc ASCII format (*.asc) and the IDRISI raster format (*.rst) the most common 
formats. These file types can be used in the MAP COMPARISON KIT (MCK). 

3.4.1.2 Creating log maps 

Log maps can be created by clicking on the option Log maps…on the Options menu as 
described in the section Log maps. When turning on the log functionality, remember 
that more maps you select and more disk space you need to save them. 
 
You can decide yourself how many maps you want to store for eventual analysis. You 
can open these maps in the MCK (part of the WISE package) or a common GIS 
packages, for further analysis after the simulation has run. 

3.4.1.3 Creating animations 

Animations are movies that show the spatial developments (e.g. land use, accessibility, 
…) over time. Animations can be created by clicking on the option Animate maps… on 
the Options menu as described in the section Animate maps. All selected maps which 
are categorised by model blocks will be saved in Animated GIF format which you can 
play in a web browser or picture viewer. 

3.4.1.4 Writing model results to Excel 

Model results can be written to Excel by clicking on the option Write to Excel on the 
Options menu. A Write to Excel settings window pop-ups that allows you to select what 
information you would like the WISE system to write to Excel. For a detailed 
explanation on how to write information to Excel, go to the section Write to Excel. 

3.4.2 Running the simulation 

Land use change has a spatial as well as a temporal aspect. The spatial aspect is 
visible in the form of a map; the temporal aspect is included in the dynamic 
computation of changes. You have learnt to create your integrated scenarios in last 
section. You will investigate what outcome the integrated scenarios will produce. 
 Make sure you have opened your project file of interest in WISE on your screen. 
 Activate your integrated scenario from the dropdown list next to Integrated scenario 

on the toolbar. For more information, see the section Active integrated scenario. 
 
The selected integrated scenario is loaded into the system. When the Step, Run and 
Reset buttons on the toolbar become enabled, the system is ready to run. To run a 
simulation, you have the following basic options, which are also described in the 
section Toolbar. You can find these buttons on the toolbar on the top of your screen, 
but you can also access to them through the Simulation menu): 

 When you press Step, WISE computes the change for one year.  

 Run lets the simulation run until the final year or the next pause. By default 2050 is 
the final year for this version of WISE.  
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 Stop lets the simulation stop at the end of the year it is currently computing. 

 Reset finally resets the simulation to the initial starting year, in this case 2006.  
 
Besides the basic functionality there are two advanced options to run a simulation: 
Update and Pauses. These options can be found through the Simulation menu. They 
are described in the section Simulation menu. 

3.5 Visualising indicators 

The basic output WISE produces are maps (land use map, climate maps, hydrology 
maps, water quality maps and threatened environment map) and numerical values. 
However, these maps and figures are not always easy to interpret at first instance. For 
that reason, WISE offers you the opportunity to compute indicators as well. An indicator 
in this context is a measure to make a particular phenomenon perceptible that is not –
at least not immediately– detectable.  
 
Indicators are organised in four groups in the user interface:  

 Social indicators 

 Economic indicators 

 Environmental indicators 

 Land use indicators 
 
Some of these indicators describe a state or a condition (e.g. the maps under the 
Environmental indicators section, the age-cohort figure and the numerical values in the 
tables) and others show a change over time (the timeline graphs). The first set of 
indicators for the start year is already available when starting up the simulation; for the 
second set the simulation requires a step first; otherwise no change can be calculated. 
 

 
 
You can visualise the social indicators, economic indicators, environmental indicators 
and land use indicator at any point in time (any year) during the simulation. To visualise 
an indicator, take the following steps: 
 Go to the Indicators tab of the Main window. 
 Select sections in the navigation pane on the left hand side of the Main window the 

type of indicator you are interested in: Social, Economic, Land use and 
Environmental. 

 
To visualise the numerical values in the table or single values 
 Go to the Social section of the Indicators tab. 
 Click the Density tab. 
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 Select your residential land use of interest on the dropdown list next to Land use. 
The values of the density, the lower bound and the upper bound for each district 
and for the selected residential land use are displayed on the screen. 

 

 
 
Particularly, if the density for the selected land use is between the lower bound and 
upper bound, the values are highlighted with green background. If the density for the 
selected land use is smaller than the lower bound or bigger than the upper bound, the 
values are highlighted with red background.  

 Density smaller than lower bound indicates that the proportion of people living in 
the selected residential land use is too small. 

 Density bigger than upper bound indicates that the proportion of people living in the 
selected residential land use is too big. 

 
You need to adjust the proportion of people living in each residential land use category 
via the Policy measures section under the Drivers tab. For more information, see the 
section Policy measures.  
 
To visualise time line graphs 
 Go to the indicator group of interest the Indicators tab.  
 Select your district or sector of interest on the dropdown list. 
 Click the graph icons  behind the names of your variables of interest. The 

corresponding time line graph window opens where changes are displayed over 
time. 

 
 
To visualise the chart and figure for the social indicators 
 Go to the Social section of the Indicators tab.  
 Click the Population tab to view the age cohort figure for the current simulation 

year. 
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To visualise detailed environmental indicator maps 
 Go to the Environmental section of the Indicators tab.  
 Click the Show map button next to the indicator of interest. The corresponding map 

is displayed in a map window. 
 
All spatial indicators can be stored in log maps and as animations. All other indicator 
results can be written to Excel. For more information about how to writing information to 
Excel and how to create log maps and animations, see the section Saving results. How 
to compare indicators over time and between scenarios is described in the section 
Analysing results. 

3.6 Analysing results 

The final step of the impact assessment study is to analyse results within an integrated 
scenario (e.g. the temporal evolution of an integrated scenario) or to compare a set of 
integrated scenarios. 

3.6.1 Analysing spatial results 

In order to analyse spatial results (maps) more carefully it is often helpful to analyse 
them pixel by pixel or to compare only the land use type you are interested in.   
You have run the simulation with different integrated scenarios and saved result maps 
using Log maps command on the Options menu. To investigate these maps you will 
use the Map Comparison Kit, abbreviated to MCK. This is a tool that contains a 
multitude of algorithms to compare maps on a pixel by pixel basis. For more 
information, we refer to the accompanying MCK user manual of the MCK software. 

3.6.1.1 Short overview of the MCK 

An overview of the MCK looks as depicted below.  
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The Map Comparison Kit application window consists of the Menu bar, the Toolbar and 
the Work pane. You can simultaneously open different windows for maps and statistics. 
Furthermore, it is possible to keep the Comparison Settings dialog window opened 
while working with the tool: 

 The 1st Map window contains the first map to compare/analyse. To change the 
contents of toolbar the 1st Map window, choose another map from the dropdown 
list next to the 1-button on the. If the 1st Map window is not open yet, then you can 
do so by clicking the 1 button. 

 

 The 2nd Map window contains the second map to compare/analyse. To change the 
contents of the 2nd Map window, choose another map from the combo box next to 
the 2-button on the toolbar. If the 2nd Map window is not yet open, then you can do 
so by clicking the 2 button. 

 

 The Result map window contains the result map. This map shows the spatial result 
of the last performed map comparison. Depending on the selected comparison 
method the results are presented in a continuous scale or a nominal scale. 

 

 The Result statistics window contains the statistical results of the last performed 
map comparison. 

 

 The Comparison settings dialog window allows setting and viewing the settings 
belonging to the active comparison method. 

3.6.1.2 Comparing different years of one scenario 

First we will analyse how the maps of the Baseline integrated scenario changes over 
time: 
 Go to the Analysis tab in the navigation pane on the left hand side of the Main 

window of WISE. 

1
st
 Map 

Menu bar Toolbar 

2
nd

 Map Result map 

Comparison settings 

Result statistics 

Work pane 
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 Press the Open Map Comparison Kit button in the content pane on the right hand 
side of the window. The Open dialog window of the MCK opens.  

 Click the Cancel button in the Open dialog window. 
 Select the Open option on the File menu of the Map Comparison Kit. The Edit Log 

File dialog window of the MCK opens. 

 

 
 

 Click the New theme item and give a name Land use for the new group of maps 
that you are going to import. 

 Press the Import… button in the Edit Log File window. The Import… dialog window 
opens.  

 
You will find the logged maps (*.rst) of the baseline scenario in the folder of \My 
documents\ Geonamica\WISE\Log by default or in the specific folder that you defined 
in the section Log maps. 
 Select the *.rst in the Files of type box. 
 Select the map that you want to compare. Repeat this step to import all the maps 

that you want to compare. The imported maps are displayed on the Land use list. 
 Click the OK button in the Edit Log File dialog window. A Save as dialog window 

opens where you are required to name and save the project file of MCK in *.log 
format. Name the log file and press the OK button in the Save as window. 

 
A *.log file is actually a file which contains a reference to one or several maps that you 
want to perform comparisons. When you open a log file in MCK, you can easily load all 
maps referred in the log file. 
 Select the maps that you want to analyse from the dropdown list in the toolbar next 

to  and next to , for instance, Land use map_2006.rst as Map 1 and Land use 
map_2030.rst as Map 2. 

 Click the 1 button to open the land use map for 2006 in the 1st Map window and 
click the 2 button to open the land use map for 2030 in the 2nd Map window. 

 
Note that the current legends in the left side of the map windows are still set by default. 
There are two ways to change the legend files of the land use maps that you imported 
in the MCK. 
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 Edit the legend one by one in the Legend Editor by clicking on the Legend… option 
on the Edit menu on the menu bar. For more information, we refer the MCK user 
manual. 

 

 Copy the content of the land use legend file \My 
documents\Geonamica\WISE\Legends\LandUse.txt that you used in WISE to the 
legend file \Legends\Land Use.txt that the Land use theme in MCK is used. This 
way you can have the same legend for the land use maps in MCK as the one used 
in WISE. 

 
Now you are going to set comparison algorithm. 

 Click the Algorithm button  on the toolbar. The Comparison algorithm dialog 
window opens. 

 Click the checkbox in front of Per category in the Comparison algorithm window. 
Press the OK button on the top-right of the window. 

 Now to choose which land use you want to investigate, click the Parameters button 

 on the toolbar. The Algorithm settings: Per category dialog window opens. 
 Select Commercial land use and click the OK button in the Algorithm settings: Per 

category dialog window. 

 Click the Compare button  on the toolbar. Now the Result map: Per category 
Commercial opens where there are 4 options available: in none of the maps, in 
both maps, only in map 1 and not in map 2 and only in map 2 and not in map 1. 

 
Besides the land use map, you can also analyse other categorical maps in the same 
way. To do this, import and select another type of categorical map from the dropdown 
list on the toolbar and repeat the steps above. 
 
If you are interested in looking at the statistical information regarding the changes, you 
can go to the option Result statistic on the Options menu or press the Statistics button 

 on the toolbar. 
 
Numerical maps, like the accessibility maps, suitability maps etc that show numerical 
values, can be compared using measures that can be found under the Compare 
numerical maps in the Comparison Algorithm window. 
 
Select the total potential maps for certain land use (or any other numerical map) in the 
dropdown list on the toolbar. 
 Click the Algorithm button on the toolbar. The Comparison Algorithm dialog window 

opens. 
 Select Comparison Algorithm → Compare numerical maps → Cell by cell → b-a. 
 Investigate the changes in total potential for certain land use over time. 
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In this exercise you have investigated the actual land use change over one simulation. 
A more interesting investigation would be to compare the results of two different 
scenarios. This you will do next. 

3.6.1.3 Comparing output maps of integrated scenarios 

The simulation that you used until now, the Baseline integrated scenario, represents an 
extrapolation of observed historic developments combined with expected future 
developments. You can say it shows a „business as usual‟ scenario that incorporates 
the processes as they are observed in the past and expected for the future. However, 
the full power of a spatial decision support system lies not in this baseline integrated 
scenario but in investigating different integrated scenarios and analysis of scenarios 
and effects of policy measures. Hence it helps you to answer “what if. . . .” type of 
questions.  
 
In this exercise you will compare an alternative integrated scenario with the Baseline 
integrated scenario. For this we will again use the MCK.  
To incorporate the logged maps from the alternative integrated scenario,  
 Go to the option Log file… on the Options menu. The Edit Log File dialog window 

opens. 
 Press the Import… button on the right hand side of the Edit Log file window. 
 Select the *.rst file type and select the logged maps of your integrated scenario of 

choice. 
 Click the OK button in the Edit Log File window. 
 
Instead of comparing the start and end map of the simulation within one integrated 
scenario you can investigate the difference between two integrated scenario results. 
We will again do this per category. 
 In the MCK select the Baseline integrated scenario result map in 2030 as Map 1 

and the alternative integrated scenario result map in 2030 as Map 2.  
 
Now you can investigate the categorical maps in more detail.  
 Click the Algorithm button on the toolbar. The Comparison algorithm dialog window 

opens. 
 Click the checkbox in front of Per category in the Comparison algorithm window. 

Press the OK button on the top-right of the window. 
 Click the Parameters button on the toolbar.  
 Select your land use of interest in the Algorithm settings: Per category dialog 

window. 
 
If you have already import the logged map of the suitability map for commercial, 
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 Select the suitability maps for commercial from the dropdown list in the Toolbar in 
the MCK. 

 Investigate the changes in suitability map for commercial between integrated 
scenarios by selecting Comparison Algorithm – Compare numerical maps – Cell by 
cell – b-a. 

 
Now you can investigate the difference between the result maps of two integrated 
scenarios. 

3.6.2 Summary 

In the last section you have analysed different results maps of the WISE system. You 
have compared results from different years within an integrated scenario as well as 
results of a certain year between integrated scenarios. For this you have used the MCK 
functionality to compare categorical maps on a cell by cell basis, to compare numerical 
maps on a cell by cell basis and to show integrated statistics. 
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4 Modeller interface 
This section deals primarily with the interaction between the Modeller and the software. 
The modeller can have more detailed access to the underlying models of the system 
diagram to update data and parameters and to check the output. For details about the 
models, we refer to the accompanying Model descriptions of WISE. 
 
Only a global overview of the model itself and the features which are not directly linked 
to the model description will be described in this user manual. 
 
Detailed information about how to update data and parameters through the modeller 
user interface is given per individual model in the section Individual model components. 
Notice that setting the parameters is part of the calibration of the system. Changing the 
parameter settings can have a major impact on the behaviour of the system. If you do 
not have a good understanding of the individual models, we suggest you to use the 
default settings.  

4.1 Overview of the system diagram 

To access the modeller user interface,  
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane. The system diagram of the 

integrated models becomes visible in the content pane on the right hand side of the 
Main window. 

 
The system diagram in the content pane is the most essential feature of the user 
interface for the modeller. It shows an overview of the structure of the integrated 
models at the most abstract level and enables access to the details of the model at this 
level but also at lower levels. You should learn to use it as a graphical explorer of the 
model. You can change neither the model structure, nor its graphical representation. 
 

 
 
The WISE system has been implemented by means of the software framework 
Geonamica. Geonamica models consist of Model Building Blocks (MBBs) that contain 
the code and/or data required to calculate and execute mathematical operations 
varying from a single operation, such as the sum of two numbers, to a complex set of 
interlinked operations (set of mathematical equations). Model Building Blocks are 
graphically represented in the user interface by means of a rectangle with the name of 
the MBB in it. They are connected to one another by means of MBB-Connectors. 
 
The WISE MBBs are structured by 4 spatial levels: NZ & World, Region, District and 
Local level. The MBBs incorporated in WISE are: 

 Climate change scenarios (Climate model) 

 Hydrology (Hydrology model) 
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 Water quality (Water quality model) 

 Economics (Economic model) 

 Demography (Population model) 

 Terrestrial biodiversity (Terrestrial biodiversity model) 

 Land use (Land use change model) 

 Spatial indicators (not available in this version) 
 
The representation of the system diagram in the Main window has been created with 
the help of the following basic elements: MBBs, MBB-Connectors, Connections, and 
MBB-Dialog windows. 

4.2 Model Building Blocks (MBB) 

Model Building Blocks are represented in the system diagrams by means of a rectangle 
with the name of the MBB displayed in it. 
 

 
 
An active MBB is represented in black. When you move the mouse pointer over such a 
block its colours becomes inverted. Next, if you click on it, a dialog window will be 
open. This dialog window is the graphic user interface of the MBB. It has the function to 
receive the user input and to display the model output.  

4.3 Connectors and connections 

Variables and parameter values can be passed from one MBB to the other via 
Connections, or Pipes. MBBs will dispense variable or parameter values with the rest 
of the models via Out-connectors, and will take-in information from other MBBs via In-
connectors. 
 
The actual data exchange between MBBs is possible via a Connection between an 
Out-connector of the issuing block and the In-connector of the receiving block. Once 
there is a variable or parameter value that is exchanged, a connection is displayed in 
the diagram.  
 

Symbols Connector 

 
In-Connector 

 
Out-Connector 

4.4 Dialog windows 

Each MBB has a dialog window associated with it. It is the vehicle that permits the 
interactive exchange of information between the user and the Model Building Block. 
The MBB communicates the results (output) of its numerical operations to the user and 
it takes in the data entered (input and parameter) by the user that are required for the 
execution of the MBB. It concerns data that are internal to the MBB which it does not 
get from other MBBs via its In-Connectors. 
 
Clicking on one of the model names gives you access to the underlying model. In 
general, the dialog window that pops-up is organised in such a way that the (external) 
input, parameters, and output are displayed from top to bottom. For some MBBs, the 
structure of the dialog window might be different according to the features of the MBBs, 
such as the Economic model. 
 
In WISE, the input and output are organised by map, map file, graph, single value and 
table. The user can find the detailed description about how to edit input and display 
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output by the categories of map, map file, graph, single value and table in the section 
Editing Input and displaying output.  
 
Information on all of the underlying models and their data and parameters can be found 
in the Model description reports of WISE. For each individual model component, see 
the section Individual model components.  

4.5 Individual model components 

4.5.1 Climate model  

Projected changes to 2050 of New Zealand annual rainfall, temperature and potential 
evapotranspiration (PET) corresponding to three Intergovernmental Panel on Climate 
Change (IPCC) global greenhouses gases emissions scenarios (low, medium, and 
high) have been produced as input for the climate model in WISE.  
To access the modeller user interface for the Climate model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Climate change scenarios MBB box at the NZ & world level in the system 

diagram. The Climate model dialog window opens. 
 
The Climate model dialog window is structured so that the Input and Output parts are 
displayed from top to bottom. In WISE, maps for six climate variables are required as 
the input in the climate change model. They are: 

 Rainfall trend: the trend for mean annual rainfall 

 Rainfall variation: the variation between the actual rainfall and the trend for rainfall 

 Potential evapotranspiration trend: the trend for mean annual potential 
evapotranspiration (PET) 

 Potential evapotranspiration variation: the variation between the actual PET and the 
trend for PET 

 Temperature trend: the trend for mean annual temperature 

 Temperature variation: the variation between the actual temperature and the trend 
for temperature 

 
Depending on the climate change scenario, different maps and different combinations 
are used. For more information, see the section Predefined scenarios. These maps are 
raster maps with spatial resolution of 0.05° lat/long (approximately 5km) grid. The 
values of each map represent the mean annual values for that type of map. 
 

 
 

On the top part of the Climate model dialog window, you can select the climate variable 
of interest from the dropdown list next to Time series. For all the variables, you can 
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change the map of interest by clicking on the browse button next to the specific time 
and upload a new map.  

 For the trend type variables, such as rainfall trend, PET trend and temperature 
trend, you can add a map for a specific year by using the Add time… button on the 
right-top of the dialog window. The system calculates the interpolated values for the 
year that are not explicitly defined. You can also delete a map for a specific year by 
using the Remove time button the right-top of the dialog window. 

 

 For the variation type variables, such as rainfall variation, PET variation and 
temperature variation, the maps of 36-year period from 1972 to 2007 are used 
repeatedly for the period 1972-2007, 2008-2043 and 2044-2079. These data will be 
used to superimpose the natural year-to-year variations of these variables upon the 
climate change trends for each emission scenario to 2050. You can add a map for 
a specific year by using the Add time… button on the right-top of the dialog window. 
You can also delete a map for a specific year by using the Remove time button the 
right-top of the dialog window. If there is no variation map for a specific year, then 
the system takes value 0 as the variation for this map and for this year. 

 
In WISE, 8 predefined sub-scenarios for the climate change have been incorporated in 
the scenario manager. For more information, see the section Predefined scenarios. 
 
The climate map (rainfall map, PET map or temperature map) for a specific year is the 
sum of the climate trend map and the climate variation map for that specific year. For 
instance, the rainfall map for a specific year is the sum of the rainfall trend map and the 
rainfall variation map. It holds true for the PET map and temperature map.  
 
On the lower part of the Climate model dialog window, you can view the climate maps 
for the current simulation year by clicking the Show ### button where ### represents 
the climate map of interest.  
 
The values from the climate change scenarios will be used as input information for the 
Hydrology model. 
 

 

4.5.2 Hydrology model 

The hydrology model is a simple hydrological simulation model for annual water runoff. 
It includes the impacts of spatially-varying climate, soil and vegetation hydrological 
response. The outputs of the model are the annual runoff for each year, and the 
expected water yield in the driest summer month.  
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To access the modeller user interface for the Hydrology model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Hydrology MBB box at the Region level in the system diagram. The 

Hydrology model dialog window opens. 
 

 
 
The Hydrology model dialog window is structured so that the Input, Parameters and 
Output parts are displayed from top to bottom. In WISE, besides the output from the 
climate change scenarios, six kinds of maps are required as the input in hydrology 
model. They are: 

 Rainfall seasonality map 

 Potential evaporation seasonality map 

 Mean number of rain days map 

 Profile readily available water map 

 Flow seasonality map 
 
These maps are raster maps with a spatial resolution of 500 meter.  
 
In the Input part of the Hydrology model dialog window, you can view and edit the input 
maps for the hydrology model by clicking on the Show/edit… button next to the input 
map of interest.  
 
In the Parameters part of the Hydrology model dialog window, you can view and edit 
the Canopy storage capacity for each land use by clicking on the cell of interest and 
entering a new value. In the hydrology model, the changes in climate affect the rain 
and potential evaporation, whereas changes in vegetation affect mainly the water 
holding capacity of the plant canopy. 
 
In the Output part of the Hydrology model dialog window, you can view the annual 
runoff map and the summer flow yield map for the current simulation year by clicking 
the corresponding button at the bottom.  
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4.5.3 Water quality model 

The water quality model in WISE system is aimed at explaining and predicting average 
annual loads of nutrients from present and future distributions of point sources, climate, 
soil types, land slope, drainage characteristics, and land uses. 
 

 
 
To access the modeller user interface for the Water quality model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Water quality MBB box at the Region level in the system diagram. The 

Water quality model dialog window opens. 
 
The Water quality model dialog window is structured so that the Input, Parameters and 
Output parts are displayed from top to bottom. In WISE, besides the information on 
climate and land use, two kinds of input are required in the water quality model. They 
are: 

 Catchment area look-up table 
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 River network map 
 
You can upload a new catchment area look-up table by clicking the browse button next 
to Catchment area look-up table on the top of the window and double-clicking on the 
new file. The catchment area look-up table is a binary file containing the following 
information:  

 A list of entries with for each entry 

 Unsigned integer (32-bit) with row index in higher 16 bits and column index in lower 
16 bits 

 Unsigned integer (32-bit) with index of catchment where the index is the link ID in 
the river network 

 Unsigned short (16-bit) with the area (in m2) of the cell that lies in the catchment 
 
You can upload a new river network by clicking the browse button next to River 
network and double-clicking on the new map. The river network map is in shape 
format. The reach network is a dendrite system of reaches and nodes. Each reach has 
a single sub-catchment associated with it. A reach may also have a lake associated 
with it. Information on a reach and its associated catchment characteristics are stored 
in the properties table for each reach.  
 
You can view the river network by clicking the Show/edit map… button next to River 
network. The Input river network map window opens. You can zoom in the area of 
interest and right-clicking on the reach of interest. The selected reach becomes red. 
Click on the Properties on the context menu. The Properties dialog window opens 
where you can edit the properties for the selected reach. 
 

 
 
After editing the river network map, the system will ask you whether or not save the 
changes you made. Click on the Yes button and giving a new file name to save the 
changed river network map. 
 

 
 

In the water quality model, the point sources of nutrients are delivered from land to 
water by two ways: drainage and rain. You can view and edit the mean delivery value 
over river network for each deliver type in the table in the Input part.   
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In the Parameters part of the Water quality model dialog window, you can view and edit 
the source coefficient phosphorus, source coefficient nitrogen, drainage exponent 
phosphorus, drainage exponent nitrogen, rain exponent phosphorus and rain exponent 
nitrogen for each land use in the Land use/parameter table. You can view and edit the 
reservoir decay, stream attenuation low flow and stream attenuation high flow per 
nutrient type in the Nutrient /parameter table. 
 
In the Output part of the Water quality model dialog window, you can view the annual 
phosphorous load map and the nitrogen load map for the current simulation year by 
clicking the corresponding button at the bottom of the Water quality model dialog 
window.  
 

 

4.5.4 Economic model 

The economic model in WISE is designed to simulate the combined environmental and 
economic implications of economic change in the Waikato Region. The model is driven 
by scenarios of economic growth. 
 
To access the modeller user interface for the Economic model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Economics MBB box at the Region level in the system diagram. The 

Economic model dialog window opens. 
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The Economic model dialog window is structured by 7 tabs: Sector filter, Sector-land 
use correspondence, Consumption, Demand, Land use constraint, Supply and 
Indicators. 

4.5.4.1 Scroll bar and slider in the table 

 
 

The Scroll bar is located the left top part of the dialog window. Four scroll buttons are 
positioned that enable the user to arrange the tabs of the dialog window in an easier 
way to work when the 6 tabs are not all displayed in the Economic model dialog 
window.  
 

Use this command To… 

 Move to the left end tab 

 Move tabs to left 

 Move tabs to right 

 Move to the right end tab 

 
The Economic model dialog window mainly consists of tables. Some of the headings of 
the tables are not displayed completely. In general, the complete heading could be 
highlighted by moving the mouse pointer over the heading. 
 

 
 
The slider can be used to resize the width of columns in the table. Move the mouse 
pointer to the border of two columns that you want to enlarge. Then press the left 
button of the mouse and drag to resize.  
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4.5.4.2 Sector filter 

On the Sector – land use correspondence tab, the Parameters table consists of the 48 
sectors of WRDEEM and the variables related to the external factor, policy measures 
and indicators. The sectors on the list will be filtered for display in the external factors, 
policy measures and economic indicators in WISE. A default selection is implemented 
in WISE.  
 
You could adjust the selection by selecting/unselecting the check box in the row and 
column of interest. The selected sector (in row) will be displayed for the selected driver 
or indicator in the policy user interface.  
 

 

4.5.4.3 Sector – land use correspondence 

The Sector – land use correspondence tab is structured by the Parameters section and 
the Output section.  
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On the top of the Sector – land use correspondence tab, a default Sector to land use 
correspondence table is shown, representing the land use functions of the land use 
change model in the rows and the sectors in the columns. Here we specify the extent 
to which each land use function contributes to each sector. The ratio coefficients in the 
Sector to land use correspondence table are used to convert land use demand per 
sector to land use demand per function. 
 
You can view or adjust the relation between land use functions and sectors by clicking 
on the corresponding cell in the table, and adjusting the ratio coefficient. Note that the 
values are fractions and that all fraction for one sector should add up to exactly 0 or 1. 
 
Press the Apply button under the Sector to land use correspondence table to confirm 
the modification. One system message window will pop up to remind you to reset the 
coefficients if the values for each sector don‟t sum to 0 or 1. The system enables you to 
undo changes in coefficients you have made since its last applied state by means of 
the Reset button in the Economic model dialog window. The Apply button and Reset 
button are only active after a change has been made. 
 

 
 
On the bottom of the Sector – land use correspondence tab, you find the Inverse 
correspondence table representing the land use functions of the land use change 
model in the rows and the sectors in the columns. Here the outputs of the extent to 
which each sector contributes to each land use function are shown. The ratio 
coefficients in the Inverse correspondence table will be used to convert land use 
demand per function at the local level to land use demand per sector at the regional 
level. In the inverse correspondence table, all fraction for one function should add up to 
exactly 0 or 1 
 
The values of the Inverse correspondence table are updated over time. You can 
observe the change of the Inverse correspondence table after taking one step 
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simulation if the change of the ratio coefficients has been made in the Sector to land 
use correspondence table. 

4.5.4.4 Consumption 

The Consumption tab is structured by Input, Parameters and Output section. You can 
review and edit the inputs in the table of Input section. This represents the initial 
household consumption per sector for the start year of the simulation.  
 

 
 
In the middle of the Consumption tab, you can review or edit the consumption scalars 
per age-sex cohort in the table of the Parameters section. The consumption scalars are 
used to convert the outputs from the population model to the average person 
equivalent. 
 
On the bottom of the Consumption tab, it features the output of the current household 
consumption for each sector. The values of the Current household consumption table 
are updated over time. You can observe the changes in the Current household 
consumption table after taking one step simulation. However, in order to have the 
consistent parameter values over time, it is suggested to reset the simulation before 
running it. 

4.5.4.5 Demand 

The Demand tab is split in 3 parts by sections: Input, Parameters and Output section. 
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In the Input table of the Demand tab, the system allows you to edit the input of 
International exports, Interregional exports, Gross fixed capital formation and Changes 
in inventories for a specific year.  
 

 
 
You can select a specific year from the dropdown list Time. The table then shows the 
input for this selected year. You can edit the values per specific year. 
 
The system enables the user to edit the time list by using the Add time function and the 
Delete time function. The Enter data and time dialog window opens when the Add 
time… button is clicked. You can enter the specific time in the text box of the Enter 
data and time dialog window.  
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After you press OK, the specific time will be displayed immediately on the dropdown list 
Time. The system takes the interpolated value for the new added time on the basis of 
the values for the specific years on the dropdown list. 
 

 
 
You can easily delete the table for one specific year by selecting this specific year on 
the dropdown list next to Time and press the Remove time button on the top. A 
message window opens. Press the Yes button of the message window to carry out the 
action of deleting table for the selected year. Press the No button of the message 
window to cancel the action of deleting table for the selected year.  
 
In the middle of the Demand tab, the Inverse Leontief matrix from sector to sector is 
editable in the Parameters section. The inverse Leontief matrix shows how the output 
of one sector is an input to each other sector. Each column of the inverse Leontief 
matrix reports the monetary value of a sector‟s inputs and each row represents the 
value of a sector‟s outputs. Suppose there are three sectors. Column 1 reports the 
value of inputs to sector 1 from sectors 1, 2, and 3. Columns 2 and 3 do the same for 
those sectors. Row 1 reports the value of outputs from sector 1 to sectors 1, 2, and 3. 
Rows 2 and 3 do the same for the other sectors. 
 
On the bottom of the Demand tab, the output of the Demand module includes the Final 
demand and the Output in mln$2004 per sector. The outputs are updated dynamically 
over the simulation period. 

 The Final demand of the Demand tab is calculated on the basis of International 
exports, Interregional exports, Gross fixed capital formation, Changes in inventories 
and the Current household consumption in the Consumption tab. 

 The Output per sector of the Demand tab is the output of all sectors which are 
caused by the Final demand for this specific sector. 

4.5.4.6 Land use constraint 

After the Final demand and Output of the Demand module are calculated, the land use 
demand estimated in the Land use model are taken into account as depicted on the 
Land use constraint tab. This Land use constraint tab is split into Parameters section 
and Output section. 
 
On the top of the Land use constraint tab, you can view and edit the Land use 
productivity per sector. The Land use productivity is used to convert the mln$2004 per 
sector to hector and vice versa. 
 



 

WRC Doc # 2012288 Page 111 

 
 
On the bottom part of the Land use constraint tab, two tables are displayed as the 
outputs which are updated over the simulation period.  

 The Unconstrained land use demand per land use function is the demand from the 
economic model. 

 

 The Constrained land use demand per land use function is the demand that could 
be allocated, as constrained by the available space in the land use change model. 

 

 The Output corresponding to constraint land use per sector is output based on the 
constrained demand from the land use change model. 

 

 The Change in output due to land use constraint per sector is the difference 
between Output corresponding to constraint land use and the Output of the 
Demand tab. It therefore expresses the missed economic opportunity due to a lack 
of available space. 

4.5.4.7 Supply 

The Supply tab is split in 3 parts: Input, Parameters and Output section. 
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On the top part of the Supply tab, the system allows you to view and edit the Ghosh 
matrix from sector to sector. 
 
On the bottom part of the Supply tab, you can observe the Change in final demand per 
sector which is updated over the simulation period. 

4.5.4.8 Indicators 

The Indicators tab is structured by the Input, Parameters and Output sections. 
 

 
 
On the top of the Indicators tab, it shows the Input table where you can view and edit 
the initial values of the indicators per sector for the start year of the simulation. It should 
be noted that the initial value must be non-negative. 
 
In the Parameters table you can view and edit the Rate of change in labour force 
productivity and the Rate of change in land use productivity per sector. On the bottom, 
you can see the output of indicators per sector. 

 The Current growth factor in the first column of the Output table shows the ratio of 
output in the current year to the one in the previous year. 
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 The Current value added and current employment take into account the current 
growth factor and their values in the previous year. 

 The Current international imports take into account the Current growth factor and 
the Initial international imports. 

 The Current employment takes into account their values in the previous year, the 
current growth factor and the Rate of change in labour force productivity. 

 The rest indicators of the Output table take into account their values in the previous 
year, the current growth factor and the Rate of change in land use productivity. 

4.5.5 Population model 

The population model in WISE system generates possible future populations, referred 
to as population projections, starting from a given base population and assumptions 
about the demographic processes of fertility, mortality and migration. 
To access the modeller user interface for the Population model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Demography MBB box at the District level in the system diagram. The 

Population model dialog window opens. 
The Population model dialog window is composed of two tabs: Population and 
Residential land use demand. 

4.5.5.1 Population 

The Population tab on the Population model dialog window is structured so that the 
Input, Parameters and Output parts are displayed from top to bottom.  
 

 
 
All data inputs to the population model (base population, migration rates, fertility rates, 
and survivorship rates) are contained in a Microsoft Excel spreadsheet. This Excel 
parameter file includes the data necessary required by the population model for a 
simulation: 

 Survivorship rates by single year of age and gender per district  

 Fertility rates by single year of age for all females aged 13-49 per district 

 Base population by single year of age and gender per district 

 Additional migration from Economic Development Assumptions (EDA) per district 

 Migration rates by single year of age and gender per district 
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In the Input part, you can upload a new population parameter file by clicking the browse 
button next to Excel parameter file.  
 
You can view and edit the first year and the last year of the data in the Excel parameter 
file in the text box next to First year and Last year, respectively. The column B of each 
sheet in the excel parameter file is interpreted as the year that you determined in the 
text box next to First year. The year in the text box next to Last year just indicates the 
range of columns of each sheet that are available in the excel parameter file.  
 
In the Parameter part of the Population model dialog window, first of all, you can view 
and change the value for Birth gender bias towards boys. 
 
The survivorship rates, fertility rates, and migration rates in the population model can 
all be altered in order to test the effect of different policies on the projected population. 
Of course, this would require some assumptions to be made about the impact of 
policies on the demographic variables. These policy levers are displayed in the table of 
the Parameters part: Fertility lever, Mortality lever, Net migration lever per district and 
EDA population effect per district in the start year and the end year of the simulation. 
The system takes the interpolated values for other years. 

 Fertility lever: the percentage of increase or decrease for the fertility rate 

 Mortality lever: the percentage of increase or decrease for the mortality rate 

 Net migration lever: the percentage of increase or decrease for the net migration 
rate 

 EDA population effect: the number of additional people that migrate to a region 
based on economic development assumptions 

 

 
 
You can view or edit the value by clicking the cell of interest and entering a new value.  
 

 
 
You can specify values for these parameters for a specific year. To add or remove a 
year, click on the Edit time… button on the top of the table. The Edit moments dialog 
window opens. Press the Add… button to add a specific year. Press Generates… to 
create a series of years. Click the Delete button to remove the selected year on the list. 
The system enables you to undo changes in moments you have made to its last 
applied state by means of the Reset button in the Edit moments dialog window. Click 
the OK button to confirm the changes that you made and close the Edit moments 
dialog window.  
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An empty column for the newly added year is displayed in the table. Select the check 
box next to Interpolate. The system takes the interpolated value for the newly added 
time on the basis of the values for its closest defined years in the table. The 
interpolated values are highlighted with yellow background. You can specify the values 
for the newly added time as well. Once you give a specific value for a parameter and 
for the newly added time, this cell is displayed with a normal white background again.  
 

 
 
In the Output part of the Population tab, you can view the output for total population, 
male population and female population by single year of age and per district for the 
current year of the simulation. You can also view the average life expectancy by 
gender per district and the natural increase in people and in percentage per district for 
the current year of simulation. Click the dropdown list under Output and select the 
variable of interest. The results for this variable are displayed in the table.  
 

 

4.5.5.2 Residential land use demand 

The Residential land use demand tab on the Population model dialog window is 
structured so that the Input, Parameters and Output parts are displayed from top to 
bottom.  
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The table in the Input part shows the population density per residential land use class 
and per district. You can view and edit the density in this table. The residential land use 
classes include:  

 Residential – Lifestyle blocks 

 Residential – Low density 

 Residential – Medium to high density 
 
In the Parameters part of the dialog window, the proportion of people that live in each 
residential class is displayed per district and for the selected year. You can view and 
edit these values by clicking the cell of interest and entering a new value. The sum of 
the proportions of people for each district should be exactly 1. If this is true, the Sum 
column in the table is highlighted with green background; otherwise, it will be 
highlighted with red background. That means you should change the values for that 
district to meet the condition that the sum of the three residential classes should be 1. 
 
The values of the proportions of people for the start year of the simulation are given by 
default. You can specify the values of proportion of people for a specific year. To do so, 
click the Add time… button in the Parameters part. The Enter date and time dialog 
window opens. In the text box, you can enter a new year for which you want to specify 
the values. Once you press the OK button, the newly added year will be displayed on 
the dropdown list next to Time on the Residential land use demand tab. 
 

 
 
By default, the system takes the values for the previous specified year as the values for 
the newly added year. Select the newly added year from the dropdown list next to 
Time. You can now view and specify the values for this year in the table. The system 
takes the values for undefined years on the basis of linear interpolation of the values 
for its two closest defined years. 
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You can remove the added year(s) from the dropdown list next to Time by clicking on 
the Remove time button on the top of the table. The start year of the simulation is not 
removable. 
 
In the Output part of the Residential land use demand tab, the table shows the land use 
demand in cells per residential land use class and per district for the current simulation 
year. 
 

 
 

4.5.6 Land use change model 

To access the modeller user interface for the Land use change model 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram is displayed in the content pane on the right side of the window. 
 Click the Land use MBB box at the Local level in the system diagram. The Land 

use change model dialog window opens.  

4.5.6.1 Land use classes 

Land use is classified in categories, some of which are modelled dynamically while 
others remain static. Dynamic land uses are called Functions or Vacant land uses. 

 Vacant states are classes that are only changing as a result of other land use 
dynamics. Computationally at least one vacant state is required. Typically 
abandoned land or natural land use types are modelled as vacant state, since they 
are literally vacant for other land uses or the result of the disappearance of other 
land use functions. 

 

 Functions are land use classes that are actively modelled, like residential or 
industry. Functions change dynamically as the result of the local and the regional 
dynamics. 

 
The non-dynamic land uses are called Features. Features are land use classes that 
are not supposed to change in the simulation, like water bodies or airports. However, 
they do influence the dynamics of the Function land uses, and thus influence their 
location. For example a Function „Tourism‟ would be influenced (expressed by a spatial 
interaction rule) by the occurrence of the Feature „Beach‟, due to the simple fact that 
tourists tend to recreate near the sea at the beach. 
 
In WISE, the following land uses are modelled: 
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Land use States 

Bare Surfaces Vacant 

Indigenous Vegetation Vacant 

Other Exotic Vegetation Vacant 

Wetland Vacant 

Residential - Lifestyle Blocks Function 

Residential - Low Density Function 

Residential - Medium to High Density Function 

Commercial Function 

Community Services Function 

Horticulture Function 

Biofuel Cropping Function 

Vegetable Cropping Function 

Other Cropping Function 

Dairy Farming Function 

Sheep, Beef or Deer Farming Function 

Other Agriculture Function 

Forestry Function 

Manufacturing Function 

Marine Feature 

Aquaculture Feature 

Utilities Feature 

Mines and Quarries Feature 

Urban Parks and Recreation Feature 

Fresh Water Feature 

Airports Feature 

Land Outside Study Area Feature 

Marine Outside Study Area Feature 

4.5.6.2 Overview 

The Land use model dialog window has been grouped in so-called Control pane and 
Content pane which are indicated in the red and in the green frame respectively in the 
figure depicted below. 
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In the control pane, you can select a land use class of interest in the land use change 
model from the dropdown list next to Land use. The selected land use type is displayed 
on the right side of the control pane.  
 
The content pane is structured by tabs. Each tab has its own dialog window allowing 
you to set parameter values and view results. The content of these dialog windows for 
the same tab can differ per land use type.  
 
The content pane is structured by Land use tab, Neighbourhood tab, Accessibility tab, 
Suitability tab and Zoning tab.  
 
Most of the contents in the content pane are related to the selected land use in the 
control pane except that the Input and Parameters parts on the Land use tab, 
Neighbourhood tab and Zoning tab are for all the land uses. 

4.5.6.3 Land use 

Click the Land use tab to access the contents depicted as the figure above. 
 
The Input part is on the top of the Land use tab. The system allows you to view or edit 
the initial land use map here. You can change the initial land use map by clicking on 
the browse button next to Initial land use map and selecting the file that you want to 
import.  
 
A Map window of Initial land use map opens after pressing the Show/Edit… button on 
the left side of the text box. You can view or edit the initial land use map via the map 
window. For more information about how to work with an editable map, see the section 
Editable map. 
 

Control pane 

Content pane 
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Land use changes after the start year of the simulation can be incorporated as land use 
deltas. These can be used to change the presence or location of the incorporated 
feature classes. Since vacant and function classes are allocated by the model, 
changes in these cannot be made explicitly in the system. It is recommended to 
prepare your land use deltas map in a GIS package before you import it into WISE. 
The land use delta map should only include the information on the land use feature 
classes. If you have a new land use map for a specific year, you can extract the 
location of the land use feature classes in a GIS package into a new land use delta 
map. This new extracted map will be used as one land use delta for specific year. 
 
You can use the Add time… or Remove time… button to add or delete the land use 
changes. The description about how to add or delete the map files is available in the 
section Map file.  
 
When you move the mouse over a land use change on the map file list and click on it, 
this land use change is highlighted with blue background. Then press the Show current 
land use map and selected changes… button at the bottom of Input section, and a 
Land use changes map window opens which is an overlay of the land use map for the 
current simulation and the selected land use changes.  
 
The Parameters part is in the middle of the dialog window. You can edit and view the 
general parameters for the land use change model here: Random coefficient and Total 
potential formula. These parameters work for all the land uses. In this version of 
software, the total potential formula is not editable. 
 
The random coefficient controls the stochastic perturbation effect to simulate the effect 
of unpredictable occurrences. The system enables you to enter the Random coefficient 
in the Parameters part on the Land use tab. The value of this parameter must be not 
less than 0. According to our experience, range of (0, 2) is recommended. A value of 0 
means no random effects. 
 
You can determine the Random seed to run the simulation.  

 Select the radio button next to Variable to run the simulation in full random mode.  

 Select the radio button next to Fixed to run the simulation in a pseudo-random 
mode. You can enter the number of random seed in the text box next to Fixed to. 
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The total potential for function states combines the effect of the neighbourhood, 
suitability, zoning and accessibility. The total potential for vacant states is a function of 
its suitability only. The default total potential algorithm is displayed in the text box under 
Total potential formula.  
 
There are two kinds of output maps on the Land use tab: the total potential map and 
the current land use map. 
 
You can view the total potential map of the current simulation year for the selected 
vacant or function land use by pressing the Show total potential map button in the 
Output part. A potential map displays the transition potential of a cell to allocate to the 
land use specified. On the basis of the transition potentials the model decides which 
land use will be allocated to each cell in the next simulation step. Colours in the total 
potential map range from red to green. Cells in red are not attractive for the indicated 
land use. In contrast, the green cells are. In the legend of the potential map you find 
next to the colour symbol two numbers. The figure to the right is the upper limit of the 
category. The figure to the left is the lower limit. Since the total potential map is only 
calculated for each vacant and function land use, the Show total potential map button 
in the Output part is not available for feature land uses. 
 

 
 
You can view the land use map of the current simulation year by pressing the Show 
current land use map button in the Output part.  

4.5.6.4 Neighbourhood 

The neighbourhood rules table displays the influence land uses have on each other, as 
used by the land use change model. For example, people do not like to live close to an 
industrial area, so industry will have a negative influence on housing that decays as the 
distance between the two places increases. 
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The influence that a certain land use has on another land use (or itself) is described as 
a function of the distance between two cells (a so-called spline), which is made up of a 
series of points that are connected. An example of such a function is shown in the 
figure above, where the points are connected by linear interpolation. In this graph, the 
distance runs along the horizontal axis and the vertical axis displays the influence that 
land use A has on land use B. We see that, when land use A and B are situated at a 
distance of 1 (cells), land use B has a positive effect on land use A of approximately 5. 
 
Click the Neighbourhood tab to access the contents depicted as the figure below. The 
dialog window is divided by 4 panes: Overview pane, Graph pane, Distance pane and 
List pane.  
 

 
We now describe all the functionality on the Neighbourhood tab dialog window, as 
indicated in the figure above. 
 
In the Distance pane, you can determine the units for displaying the distance in the 
neighbourhood in the list pane and the graph pane, either in meters or in cells. 
 
In the Overview pane, the influence table displays the influences of each land use on 
each function land use: From… To…. Some of the cells in this table show what the 
spline that describes the corresponding influence looks like. If a spline is flat (0 
influence for all distances), it is not displayed in the table. Click on a cell in the table to 
select that interaction rule. The spline that describes that influence is displayed in the 
Graph pane of the dialog window. 
 

Overview pane 

Graph pane 
List pane 

Distance pane 
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Auto save changes. When you select another cell in the influence table or when you 
close the Land use change model dialog window, if the check box is selected, changes 
that you made will automatically be saved; if not, when you activate another rule, a 
window will pop-up and ask you whether or not to save the change that you made.  
 

 
 
In the Graph pane, the Spline graph displays the neighbourhood rule that is currently 
selected in the influence table. You can find the name of this rule above the graph. The 
x-axis represents the Distance and the y-axis represents the Value of influence. The 
points of the spline are displayed as small circles, which are connected by a blue line.  

 Points in the graph can be moved by dragging them with the mouse. When you 
click on a point, it turns red. Holding Ctrl or Shift and clicking on a point will 
(de)select multiple points. If you hold Ctrl or Shift, you can also make a selection 
rectangle by dragging with your mouse. All points within the selection rectangle will 
be added to the selection when you release the left mouse button. By selecting 
several points, you can move all of them without affecting their mutual relation, with 
the constraint that points cannot be dragged outside the graph area. 

 

 Right-clicking on a point in the graph will open a small dialog that allows you to view 
or enter the coordinates of a point, as shown in the figure below. At the bottom of 
this Edit point dialog window, a note for the range of X values is given. You can 
only enter values for X that fall in this range; otherwise a message pop-ups to 
remind you again of this range. Next paragraph describes how to determine the 
ranges of X and Y.  

 

 
 
Display options. This opens the Spline display options dialog window as shown in the 
figure below. In this dialog window, the extent of the graph can be altered.  

 The system allows you to determine the range of the x- and y-axis enter the lower 
and upper bounds in the text boxes.  

 When the Display grid check box is checked, grids are drawn in the Graph pane. 
When the Display ticks check box is checked, vertical lines at all possible cell 
distances are drawn in the Graph pane.  

 

 
 

Apply. This will save changes you have made to the current spline. It is available only 
after you made a change.  
 
Reset. This will undo changes you have made to the current spline, by resetting it to its 
last saved state. The Reset button is available only after a spline is changed and 
before you press Apply. 
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The system provides a table with the coordinate pairs for all discrete cell distances in 
the List pane on the right hand side of the window. The value list is not editable since 
interactions can be edited in the graph only. Changes made are immediately visible in 
the spline graph and on the value list. 
 
The neighbourhood influence rules describe the effect of one land use on another at 
each distance in the neighbourhood. These influences are accumulated to produce the 
neighbourhood effect in each cell for each land use function. The neighbourhood 
potential map shows this neighbourhood effect for the selected land use function for 
each cell, which will be used to calculate the total potential map. 
 
You can view neighbourhood potential map for the current simulation year by clicking 
the Show neighbourhood potential map button in the Output part of the Land use tab. 
The Neighbourhood potential for the selected land use function map window opens. 
Colours in the Neighbourhood potential map range from green to red. Cells in green 
have very high neighbourhood potential for the specific function land use. In contrast, 
the red cells have not. Since the neighbourhood potential map is only calculated for 
function land uses, the Show neighbourhood potential map button in the Output part is 
not available if the selected land use is feature or vacant. 

4.5.6.5 Accessibility 

Click the Accessibility tab to access the contents depicted in the figure below. 
 

 
 
The accessibility for each function land use is calculated as a function of the distance 
to the nearest infrastructure network and the weight of this particular network. It 
represents how easy a location can fulfil its needs for transportation for a particular 
land use.  
 
The input of the Accessibility component of the land use change model is the 
Infrastructure layers in WISE. You can access the detailed infrastructure information by 
clicking the Go to infrastructure layers button in the Input part. The Infrastructure layers 
dialog window opens. 
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On the top of the dialog window, the default file names and file paths for the initial 
network layers are listed in the table by Network layer name. You can adapt an initial 
network layer for the specific layer by clicking on the browse button next of the specific 
layer and selecting the file that you want to upload. You can also view and edit the 
selected initial network map by clicking the Show / Edit selected button. 
 
Clicking the Add / remove infrastructure layers button to open the Add / remove 
infrastructure layers window. You can change the name of the network layers by 
entering a new name in the text box in the Network layer column. You can adapt the 
initial network layer by clicking on the browse button and uploading a new file.  
 

 
 
You can add a new network layer by clicking the Add.. button on the upper-right side of 
the Add / remove infrastructure layers window. After entering a name and loading the 
map for the new network layer, press the OK button. The newly added network layer 
will be displayed on the list of the Infrastructure layers. You can remove one existing 
network layer by selecting it and press the Remove button on the upper-right side of 
the window. 
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You can also add a new accessibility type by clicking the Add… button on the lower-
right side. The Add accessibility type window opens. Enter the value and name for the 
accessibility type in the text boxes AccType value and Accessibility type name, 
respectively. The newly added accessibility type will be displayed on the list of 
Accessibility types. 
 

 

 
 
Click the OK button at the bottom to confirm the changes and close the Add 
accessibility type window.   
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Go to the Parameters part of the Infrastructure layers window. You can select your 
network of interest on the dropdown list next to Network layer. The detailed information 
for all the network changes for the selected layer is displayed in the table. 
 Click the Add… button to import a network change at a specific time for the 

selected network.  
 Click the Remove button to delete a network change at a specific time for the 

selected network. 
 You can view and edit each network change in isolation by selecting the change of 

interest from the table and clicking the Show / Edit selected button. 
 Click the Show / Edit selected button to display a network change in isolation at a 

specific time for the selected network.  
 
These operations regarding the Add… button, Remove button and Show / Edit selected 
button work similarly with the operations described in the section How to import a 
network at a specific time? and How to adapt a network at a specific time?. 
 
For more information about the network map window opened by pressing the 
Show/Edit selected button, see the section Network map window opened via the 
modeller user interface.  
 
You can view the high-level overview of the entire network at a specific time via the 
policy user interface. For more information, see the section Network map window 
opened via the policy user interface. The setting of network changes in the 
Infrastructure layers dialog window links directly to the setting of network changes 
under the Policy measures section. 
 



 

WRC Doc # 2012288 Page 128 

 
 
Go to the Accessibility tab of the Land use change model window. Accessibility 
parameters, which describe the influence of certain land uses to be close to elements 
of the infrastructure network play an important role in the allocation of the land use 
functions. In the Parameters part, the system allows you to specify the parameters 
used for the accessibility maps for each function land use by following steps:  
 Select the land use of interest in the dropdown list Land use in the control pane. 
 Select the check box in front of Land use is build up if the selected land use in the 

model is contained in the set of urbanised land uses (for example residential land 
use). You need to determine whether a land use is build up or not for all land uses. 

 Select the check box in front of Land use is impassable if the selected land use is 
impassable (for example water). You need to determine whether a land use is 
impassable or not for all land uses. 

 Set the implicit accessibility parameters for each land use function. The Implicit 
accessibility values range from 0 to 1. Enter the Implicit accessibility parameter for 
the selected land use function on a build-up area in the text box next to Implicit 
accessibility for build-up areas. Enter the Implicit accessibility parameter for the 
selected land use function on a non build-up area in the text box next to Implicit 
accessibility for non-build-up areas. The text boxes of Implicit accessibility 
parameters are only available when one of the land use functions in the model is 
currently selected on the dropdown list. 

 Specify the distance decay and weight parameters per land use function.  The 
parameter table allows you to set the Distance decay for the effect of each 
Infrastructure type of the network on the selected land use function and it‟s Weight. 
The distance decay is the number of cells after which the effect is halved (for 
positive decays) or doubled (for negative decays). The weight determines the 
relative importance of the infrastructure element for the particular land use function. 
The distance decay can be positive – for example, industries like to be near 
highways – or negative – for example, natural areas are preferably not located 
close to highways. With positive decays this is then the maximum value and with 
negative decays the minimum value. To turn off the accessibility effect of a specific 
land use function, you can set its weight to zero.  

 
In order to visualize the accessibility map of a function land use, it is imperative that the 
simulation has been initialised (see the section Reset) or the accessibility has been 
computed (see the section Step). Use the Step command to compute the new 
accessibility maps after the network has been changed (see the section How to adapt a 
network at a specific time?) or when accessibility parameters have been changed. 
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You can view the accessibility map of the selected land use function for the current 
simulation year by pressing the Show accessibility map button. The Accessibility for the 
selected land use function map window opens. Accessibility is expressed in the range 
0 to 1 and is displayed in colours varying from red to green: red meaning low 
accessibility (0) and green meaning high accessibility (1). All the network layers 
incorporated in the system are displayed as well in this map window. 
 
Since the accessibility map is only calculated for function land uses, the contents in the 
Parameters part and the Show accessibility map button in the Output part are not 
available if the selected land use is vacant or feature. 
 

 

4.5.6.6 Network map window opened via the modeller user interface 

The user interface of the network map window opened via the policy user interface is 
different from the one opened via the modeller user interface. In this section, we focus 
the one opened via the modeller user interface. For the other one, please refer to the 
section Network map window opened via the policy user interface. 

 You can view and edit the exact network changes for the selected network and for 
the specific year in the Network map window opened via the modeller user 
interface. 

 

 You can view the high-level overview of network layer for the selected network and 
for the specific year in the Network map window opened via the policy user 
interface. 

 
For instance, the figure below shows the network map window opened via the policy 
user interface. All the roads on the Transport network layer for 2010 are displayed. 
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The figure below shows the network map window opened via the modeller user 
interface. Only the expansion roads added for 2010 are displayed. 
 

 
 
The title of the network map window indicates the descriptive name of the selected 
network and the selected year. As depicted in the figure above, besides the District 
boundaries layer, there is only one layer Road expansion 2010 visible in the layer 
manager pane, which shows the exact network changes for the selected time in the 
map pane.  
 
The legend pane consists of 4 legend tabs which are used for editing the legend of 
network map. The Link color and Link width tab are most useful. For more information 
about how to edit legend, see the section Legend editor. For all the networks, the 
categories of Acctype are used as the legend. For more information, see the section 
Network legends. 
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The ratio buttons in the legend pane indicate that this network map is editable. You can 
view, edit the link properties or add new links on the selected network layer. 
 Select the network of interest from the dropdown list next to Network layer. 
 Select the network change for the time of interest to open the network change map 

window. 
 Double-click on the link of interest on the network changes map window. The 

Properties dialog window opens. All the available link properties of the selected 
network are displayed in the Properties dialog window. You can edit the link 
properties for the selected link from here.  

 If you want to add the selected link, enter value 0 in the cell for DeltaType.  
 If you want to delete the selected link, enter value 1 in the cell for DeltaType. 
 

 
 

 Click Cancel to close the Properties dialog window. 
 Or click OK to confirm the change that you made. A message window appears to 

ask you whether you want to save the changes you have made or not.  
 

 
 

 Specify the name and path of the file that you want to save changes to. 

 Press Save. 

4.5.6.7 Suitability 

Click the Suitability tab to access the contents depicted as the figure below. 
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Suitability is represented in the land use change model by a map for each vacant or 
function land use. Values on the suitability map quantify the effect that physical 
characteristics of the land have on the possible future occurrence of land uses. The 
suitability maps can be created with the help of the Overlay-Tool. 
 
It is important to keep the default names of these suitability maps which are assigned 
by the Overlay Tool in the case you can import one or all suitability maps generated by 
Overlay tool by clicking the Import from Overlay-Tool… button. In the Import Overlay-
Tool maps dialog window, enter the time for which you want to import the suitability 
maps; select the location where you stored all suitability maps generated by Overlay 
tool; check the check box next to Vacant land uses are included in Overlay-Tool 
project. You need to verify if the suitability maps in the File column are corresponding 
to the land uses in the Land use column by switching on or off the check box 
mentioned above. Check the check boxes for each land use in the Import column to 
import the suitability maps for the checked land uses. 
 
If you generated suitability maps using other tools, for example the ArcGIS package, 
you need to import the suitability map one by one for the selected land use by clicking 
the browse button in the path edit box. 
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The system provides you the opportunity to set up the maximum suitability (for all land 
uses) by entering a value in the range of (0, 255) in the text box next to Maximum 
suitability on the top of the Suitability tab. This maximum suitability value should be the 
highest value on any suitability map in WISE. In general, if the suitability map is created 
in the Overlay-Tool with a maximum suitability value of 10, it can be used directly in 
WISE system.  
 
The path of the suitability map file for the function land use for the first date is displayed 
by default when you open the system. The system allows you to add or delete the 
suitability map for a selected land use at a specific time by clicking on the Add and 
Delete button. The description about how to add or delete the map files is available in 
the section Map file.  
 
You can view or edit the suitability map for the selected vacant or function land use and 
for the selected time by clicking on the Show/Edit… button at the bottom of the 
Suitability tab.  
 
With the opened Suitability map window, it is possible to change the suitability value of 
individual cells. A higher value indicates a higher suitability. Suitability is displayed in 
the map in colours varying from red to green, representing values between 0 (not 
suitable) and 10 (perfectly suitable). Before you add the suitability map to the system, 
you have to ensure that the values on the map are integer values. For more information 
about how to work with an editable map, see the section Editable map. 
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4.5.6.8 Zoning 

The zoning or institutional suitability is characterized by one map for each land use 
function. It is a composite measure based planning documents available from the 
national or regional planning authorities and can contains information from among 
others ecologically valuable and protected natural areas, protected cultural landscapes, 
buffer areas, etc. 
 
Click the Zoning tab to access the contents depicted as the figure below. 
 

 
 
The input to the Zoning part of the land use model are the Zoning maps which are 
generated with the help of zoning tool in WISE. A zoning map is a categorical map with 
the zoning state values. No data values are depicted on the map as white.  
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You can access the zoning tool via the user interface of the land use model by clicking 
the Go to zoning tool button in the Input part of the Zoning tab. For more information 
about the zoning tool, see the section Zoning tool. 
 
These categorical zoning maps need to be converted into numerical zoning maps 
which have numerical values to be used in the computation of the total potential. You 
can set the parameters to interpret the categories in the Parameters part of the Zoning 
tab. The conversion takes into account the De Facto zoning and the zoning state value 
for each land use function. 

 If a check box in the De Facto zoning table is selected for certain land use and for 
certain function, each year the zoning status will be corrected for the De Facto land 
use. For instance, the check box for Agriculture land use and for the Agriculture 
function is checked, if a location has agriculture on the calculated land use map, 
you introduce a new zoning plan where the agriculture is not allowed to develop on 
this location. The zoning status for agriculture function will still be allowed at this 
location. 

 

 If a check box in the De Facto zoning table is unselected for certain land use and 
for certain function, the zoning status will be corrected for the De Facto land use 
each year. For instance, when the check box for the Agriculture land use and the 
Agriculture function is checked, a location that has agriculture on the calculated 
land use map cannot be removed as a consequence of introducing a new zoning 
plan. Even though this new zoning plan indicates that agriculture is not allowed at 
that location. 

 
You can set the zoning state values for each land use function and each zoning state 
category in the Zoning state value table. The zoning state values will be used to 
calculate the numerical zoning map.  
 
You can view the numerical zoning map by clicking the Show numerical zoning map 
button at the bottom of Zoning tab. The Numerical zoning map for the selected land 
use map window opens as depicted in the figure below. 
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4.5.7 Terrestrial biodiversity model 

The terrestrial biodiversity model in WISE performs an analysis to identify unique 
combinations of land environments, protected areas, and land use. It combines 
information on all land uses including vegetation state with information from two other 
primary data sources to produce an indicator of ecosystem representativeness. 
To access the modeller user interface for the Terrestrial biodiversity model, 
 Go to the Drivers tab of the Main window. 
 Click the Parameters icon in the navigation pane on the left side of the window. The 

system diagram displays in the content pane on the right side of the window. 
 Click the Terrestrial biodiversity MBB box at the Local level in the system diagram. 

The Terrestrial biodiversity model dialog window opens. 
 
The Terrestrial biodiversity model dialog window is structured so that the Input, 
Parameters and Output parts are displayed from top to bottom.  
 

 
 
Besides the land use map, the LENZ map and Protected area map are required as 
input in the terrestrial biodiversity model.  

 LENZ map: the Land Environments of New Zealand map shows information on land 
environments that serve as surrogates for ecosystems and habitats 
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 Protected area map: Protected areas network of New Zealand map is a database of 
legally protected areas. 

 
You can upload a new LENZ map by clicking the browse button next to LENZ map and 
double-clicking the new map.  
 
You can add a protected area map for a specific year by clicking the Add time… button 
and importing a new map for the added year. You can delete a protected area map for 
a specific year from the list by selecting the directory of map and clicking the Remove 
time button. You can view the protected area map by selecting it and clicking the Show 
/Edit button on the middle-right side of the Terrestrial biodiversity model dialog window. 
 
In the Parameters part of the Terrestrial biodiversity model dialog window, you can 
indicate whether a land use is a land use growing native vegetation by selecting the 
check box next to this land use. 
 
In the Output part of the Terrestrial biodiversity model dialog window, you can view the 
output map by clicking on the Show threatened environments map… button at the 
bottom of the window. The Threatened environments map window opens where 6 
categories are assigned to each environment: acutely threatened, chronically 
threatened, at risk, critically under protected, under protected and not threat category. 
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5 The WISE menu system 
This section explains the different functions that are available from the WISE menu 
system. Some Geonamica functions are not available in WISE. These are greyed out; 
they are visible in the menu in a light grey colour, but they do not result in further 
actions when invoked. Consequently, these functions are not described in detail in this 
section. 
 
Other functions are only accessible when they are relevant. For instance, the Stop 
command in the Simulation menu is only accessible when the simulation is running. 
 
The menus are treated as they appear in the Menu bar from left to right and per menu 
from the top to the bottom. Most commands in this section have already been 
described in other sections. You can find more detailed information for these 
commands through the links in the table.  

5.1 File menu 

You can use the File menu to open and save project files, and to exit WISE. The WISE 
system saves project files with a .geoproj extension attached to the file name. 
 

Option Function Link 

Open project… Open a project file stored on a disk Section Opening a project file 

Save project Save changes to the current project file Section Save a project file 

Save project 
as… 

Save a project to a disk Section Save a project file as 

Close project Close the project   

Recent file list Display the names and the paths of the 4 
most recently opened project files. If you 
select one of the 4 files, it will be opened 

 

Exit Quit Geonamica  

5.2 Simulation menu 

You can use the Simulation menu to control a simulation. The commands Update, Run, 
Stop and Reset can also be invoked when pressing the respective buttons on the 
Toolbar. 
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Option Function Link 

Update Recalculate variables that are affected by changes 
(except for the initial values and initial maps) via the 
user interface for the current simulation year. This 
command will not change the simulation time. 

Section Update 

Step Advance the simulation with one time step Section Step 

Run Advance the simulation till the next pause moment 
has been reached 

Section Run  

Stop Stop a simulation run Section Stop 

Reset Recalculate variables that are affected by changes 
(including the initial values and initial maps) via the 
user interface for the start year of the simulation. 
Switch the simulation clock back to the start year of 
simulation. 

Section Reset 

Pauses… Set the pauses of the simulation Section Pauses 

5.3 Maps menu 

You can use the Maps menu to select different maps and open their map windows. All 
available maps for the user are structured hierarchically by themes. There are 
essentially two types of maps: input maps and output maps. All the input maps are 
editable and all the output maps calculated for the current simulation year by the 
system are not editable. 
 

 

5.4 Options menu 

You can use the Options menu to personalise your workspace or to access the 
additional functionalities of WISE. 
 

 
 

Option Function Link 

Write to Excel Establish or interrupt a link between WISE 
and the Microsoft Excel Workbook 

Section Write to Excel 

Log maps Store maps produced by the system in the 
form of .rst files 

Section Log maps 

Animation maps Store dynamic maps produced by the 
system in the form of .gif animations 

Section Animate maps 
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Option Function Link 

Preferences Set if the geo project file will be associated 
to the current version of WISE. 

Section Adjusting file 
association in 
preferences 

5.5 Window menu 

You can use the Window menu to arrange the contents of the screen and to activate 
one of the opened windows. 
 

 
 

Option Function 

Cascade Arrange multiple opened windows in an overlapped fashion 

Tile horizontal Arrange multiple opened windows one above another in a non-
overlapped fashion 

Tile vertical Arrange multiple opened windows side by side in a non-
overlapped fashion 

Arrange icons Arrange the icons for minimized windows at the bottom of the 
screen 

List of Windows Active the selected window on the list of opened windows 

5.6 Help menu 

You can use the Help menu to select the type of help that you want WISE to display on 
the screen. The different commands in this menu permit you to look up information 
about WISE, its commands, options, and tools. 
 

 
 

Option Function Link 

Index Get the opening screen of the on-line help 
file of WISE 

Section Index 

Licence… Open the Licence window Section Licence 

Check for updates Check the version of WISE Section Checking for 
updates 

About… Open the About window Section About 
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Annex 1 WISE release history 

Version 1.2.0 (30 June 2011) 

 Improved the performance of the zoning tool 

 Changed the hydrology model to account for changes in land use 

 Fixed hydrology model parameters 

 Changed the link between the economic and land use model 

 Incorporated carbon forestry sectors in the economic model 

 Revised the user interface of the legend editor 

 Added scenario support to „log maps‟ functionality 

 Added download link for the Map Comparison Kit in the analysis section 

 Added an online version check 

 Changed license system (old licenses cannot be used anymore) 

Version 1.1.1 (3 November 2010) 

 Bug fixes 

Version 1.1.0 (17 August 2010) 

 Added „zoning tool‟ 

 Fixed computation of adjusted rates in population model 

 Password protected population parameter file 

 Fixed computation of change in final demand in economic supply model 

 Added support for addition and removal of infrastructure layers through the user 
interface 

 Added „land use indicators‟ displaying the difference between land use demand 
and allocated land over time 

 Support animation of river network maps and infrastructure network maps 

 Added integrated help functionality 

 Documented guidelines for best use of the scenario manager 

 Various user interface enhancements 
o Added „maps‟ menu 
o Added economic sector filter in policy user interface 
o Display overview of total potential figures for a single cell 
o Improved the „log maps‟ functionality 
o Made infrastructure policy measures more user-friendly 
o Removed „changes in inventories‟ from external factors 

Version 1.0.7 (16 November 2009) 

 Updated hydrology parameters (maps) 

 Renamed “eco-efficiency” as “land productivity” 

Version 1.0.6 (11 November 2009) 

 Updated land use model parameters 

 Updated colours of land use map 

Version 1.0.5 (9 October 2009) 

 Changed simulation start year from 2004 to 2006 

 Updated initial land use map 

 Updated land use model parameters 

 Fixed implementation of population model 



 

WRC Doc # 2012288 Page 144 

 Updated population model parameters 

 Changed formula to compute average life expectancy 

 Changed allocation of residential land use functions from regional to district 
level 

 Added population density model 

 Added „decay coefficient‟ to economic supply model 

 Fixed drawing of output graphs 

 Display infrastructure networks on top of accessibility maps 

 Updated „About box‟ 

 Adopted „WISE‟ as the name of the system 

Version 1.0.4 (17 August 2009) 

 Changed marine land use from vacant to feature 

 Changed aquaculture land use from function to feature 

 Updated data for land use model and biodiversity model 

Version 1.0.3 (24 July 2009) 

 Replaced catchment map with catchment area lookup-table (water quality 
model) 

Version 1.0.2 (17 July 2009) 

 Incorporated hydrology model 

 Added social indicators 

 Updated „About box‟ 

Version 1.0.0 (10 July 2009) 

 Incorporated various sub-models: 
o Climate 
o Water quality 
o Population 
o Terrestrial biodiversity 

Version 0.5.1 (1 December 2008) 

 Added suitability maps 

Version 0.5.0 (30 November 2008) 

 First prototype including land use and economic models 
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Annex 2 Associated project file and 
versions of WISE 
When you have multiple versions of WISE installed on your computer and you have 
opened the WISE geoproject file with different versions of WISE, the dialog window 
may appear as depicted in the figure below asking you whether or not you want to 
associate the WISE project file with the current version of WISE that you accessed in 
the steps described in the section Starting WISE.  
 

 
 
This functionality provides the possibility to associate project files with the extension 
*.geoproj with different versions of WISE installed on your computer. This is the case 
when there is more than one Geonamica-based system installed on your computer.  

Associating project file 

When Geonamica project files (*.geoproj) are not associated with this version of WISE, 
you will see the Associate project files dialog window on start up. 

 If you select the checkbox in front of Don‟t ask me again before you click the Yes or 
No button, your answer will be remembered next time. When you open next time 
WISE, the system will always take the action that it remembered and the system 
will not display this dialog window.  

 Clicking the Yes button on the message window above means that the next time 
you double-click the icon of the project file Waikato.geoproj, the WISE application 
window will open directly which is linked to the current version of WISE. 

 Clicking the No button on the message window above means that nothing will be 
changed. The next time you double-click the icon of the project file 
Waikato.geoproj, the application window will open with which *.geoproj files are 
currently associated.  

 It makes no difference whether you press the Yes or No button if you have only one 
version of Geonamica.exe installed on your computer. You can skip this sub-
section. 

Adjusting file association in preferences 

After defining the setting for the project file association, you can adjust it via the 
Options menu in WISE. To do so, 
 

 
 
 Go to Options menu → Preferences. The Preferences dialog window opens with 

three options. 
 Select the option of your interest and press the OK button in the File association 

part.  
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Here you can select which action should be taken when Geonamica project files 
(*.geoproj) are not associated with this version of WISE. Note that this is only verified 
when you open WISE. The default option is “Ask me what to do”. If this is selected and 
project files are not associated with Metronamica, you will see the Associate project 
files dialog window described above on start up. 
The system will check automatically if there is a newer version of WISE available if the 
check box at the bottom is selected. 

Checking the associated version 

You can check with which version of Geonamica the .geoproj project file is associated 
using the following steps. 
 Right-click on My Computer and select Explore. 
 Click on Tools from the menu bar and select Folder Options… from the drop-down 

menu. 
 Click the File Types tab in the Folder Options window. 
 Scroll down in the Registered file types: window and select GEOPROJ under the 

Extensions column. 
 Click the Advanced button near the bottom of the Folder Options window. 
 Select Open with Geonamica from the list in the Actions window and then click the 

Edit… button to the right side. 
 The Editing action for type: Geonamica®Project window opens. 
 In the text box under Application used to perform action, you can see the path of 

the Geonamica.exe with which the .geoproj file types are currently associated. 
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